ADMINISTRATION MODULE
Administration is the general system module of BCR Titan.  It contains company information and general setup for each module.  This module also controls the security features of Titan.  User passwords and access levels are controlled in this module.  It also contains options to allow you to maintain the core system files such as customers, vendors, accounts, items, etc.  All options may not apply if you are only using selected modules.  Titan also provides numerous basic table reports such as chart of accounts, item listing, vendor listing, customer listing, and item master list.  This module may be left open so that vendors and customers can be added ‘on the fly’ by clicking Alt-Tab.
Note:  Before using the system, please review the System Defaults and make changes as needed.
1. File
1.1. Edit Customers
The Edit Customers option is used to maintain the customer file.  Press the Add button to add a new customer into the system or highlight the customer you wish to edit using the mouse or arrow keys and click the Edit tab.  Note:  Customers cannot be deleted if there are transactions on file for them.
1.1.1. OK
Files any changes made to the customer and exits the screen. Note that changes are made to individual fields immediately when you click on another field. Some other programs may not reflect that change if you stay in the record. Exiting the record makes the information available to all other programs. Note too that some programs open the entire file and may not reflect changes until you exit that program and reopen it.
1.1.2. Add
Allows authorized users to add a new customer account. When clicked you will be prompted for a unique customer ID (up to six uppercase alpha/numeric characters.) You will then be prompted to enter a company name. If you change your mind and decide not to create the new customer, you must enter something in the Company field before it can be Deleted. New customer records are created with certain settings and fields prefilled from the New Record Defaults tab in System Defaults. 
1.1.3. Copy
For authorized users the Copy button will appear on the Edit Customers screen or anywhere that the customer pick list function triggers that screen, such as in order entry.  In order for a user to be able to create a new customer using another customer record the user must have the “Allow User to Create a New Customer by Copying an Existing Customer” option checked on the Accounts Receivable tab in the Setup User screen. Before clicking the Copy button, select the customer that will be copied from. Usually this will be a template customer like NEW RETAIL, or COURTESY ACCOUNT. These customers will have the basic account settings for that type of customer. After the template customer is selected and the Copy button clicked the prompt is for a new customer ID. New customer IDs are typically relevant to the customer name, such as the first three characters of the first two words in the company name.  The user is prevented from creating duplicate IDs. Only selected fields of information are copied from the source customer. Generally these are the switches on the Edit tab, basic tax and credit setup, the pricing setup (including price lists and matrix group assignment), and a number of generic information fields. Fields that are not completed on the template customer are not filled on the new customer. Real customers would not normally make good source customers unless the new customer is directly related to the source customer as a business entity. 
1.1.4. Delete
This will delete the customer record. Customers that have any transactions on file of any kind, including paid invoices, cannot be deleted. The system relies on historic transactions to build management information and reports. Deleting customer with history would distort this information. If a customer cannot be deleted but is no longer active, and you do not want to see it listed or to take orders from them, you can uncheck the Active checkbox on the Edit tab.
1.1.5. Label
Click this button to print a customer mailing label for the selected customer.
1.1.6. Previous
Moves to the previous customer in the List tab. If the customer listing is ordered by zip code then it would move to the previous customer sorted by zip code, i.e., a lower number and listed above the current record. Also insures that changes to the current customer are filed so that they will be available to other programs.
1.1.7. Next
Moves to the next customer in the List tab. If the customer listing is ordered by zip code then it would move to the next customer sorted by zip code, i.e., a higher number and listed below the current record. Also insures that changes to the current customer are filed so that they will be available to other programs.
1.1.8. Address
1.1.9. Map
If you are connected to the internet this button will search Map Quest for the address of the selected customer using address (first line), city, state and zip. 
1.1.10. Display AR
Click this button to open the Display Account Detail screen from accounts receivable for the currently selected customer.
1.1.11. List
The List tab is used to select a customer. Whatever customer is selected (indicated by the arrow in the left column) determines the data displayed on every other tab when selected. Tabs do not need to be opened in order and can be accessed randomly. The list of customers is in the order determined by the Status field, Order panel on the right, Extended Find field and the Active Only option. The order of customers in the list determines which customer will be accessed when the Previous or Next button is clicked. 
1.1.11.1.  (grid)
1.1.11.2. Status
The customer Status is assigned on either the Edit Customers Edit tab or on the Contact Management Company tab. New Statuses can be create in Contact Management as well. The Status is user defined and has no other function than to categorize and filter customer listing. Select a Status in this dropdown to limit the listing to only customers with that Status.
1.1.11.3. Order
Use these radio buttons to select how you want to search for and list customers. If ID is selected then the customers will be listed in order of their IDs and the Find field will look for IDs matching your entry. If the Company button is selected then the list and find is by company name, and so on.
1.1.11.3.1. ID
Select ID to list customers in ID order. Text entered in the Find field will search for customers with matching IDs.
1.1.11.3.2. Company
Select Company to list customers in Company Name order. Text entered in the Find field will search for customers with names beginning with those characters. You can alternately use the Extended button to list customers by name but search for customers containing that string of characters.
1.1.11.3.3. Sort Field
Maintained on the Edit tab. This field can be used for any user defined purpose, such as characters that could be used to sort customers on reports into an order that is more logical than the Company name. For example, The Acme Company might have a sort field of ACMECO so that it would be alphabetically placed with A’s rather than T’s. But it could be used to group or sort customers for any reporting purpose. The sort field can also be used to locate customers in the pick list. 
1.1.11.3.4. Zip Code
Select Zip Code to list customers in Zip Code order. Numbers entered in the Find field will search for customers with matching zips.
1.1.11.3.5. Phone #
Select Phone #  to list customers in Phone # order. Numbers entered in the Find field will search for customers with matching phone #s.
1.1.11.3.6. Extended
Select Extended to search for customers whose name contains a string of characters. With Extended selected the text entered in Find will be matched to any string of characters contained within the name rather than beginning with those characters. So WREC would find and list only companies like ACME WRECKER, whereas with the Company button selected the list would just jump to companies whose name started with WREC or the closest match.
1.1.11.3.7. Find
The Find field works in conjunction with the Order radio buttons above it. Text entered will locate the first match to the data indicated by the Order button selected in the customer list. If ID is selected then the entry in the Find field will locate the first customer with an ID matching the characters as they are entered. 
1.1.11.4. Active Only
If checked lists only those customers that are checked as Active on the Edit tab (i.e., order can be accepted from this customer.)
1.1.11.5. Office
The Office dropdown selector limits the customers listed to the office location selected, or to ALL to show all locations. Office Location is assigned to customers on the Shipping / Regional Options tab of the Edit tab. Office Locations are setup and maintained from System Defaults on the OE Switches tab. If Multiple Office Locations is checked then a browser button will appear which opens the Office Locations edit screen. If Multiple Office Locations is not checked then this dropdown selector will not appear.
1.1.12. Edit
The Edit tab contains general customer information and default pricing and shipping settings.
1.1.12.1. General Information
1.1.12.1.1. ID
The customer ID must be unique for each customer. It is up to six alpha/numeric (uppercase) characters and is usually significant (e.g., Acme Company might be ACMECO) since it can be used to locate customers in a lookup.
1.1.12.1.2. Status
The status is a user defined designation created through the Contact Management module. It is only used for customer categorization, lookup, and reporting and has no restrictive function in the system.
1.1.12.1.3. Company
Contains the company name that will be used for lookup and as the name associated with the customer throughout the system. Bill To and Ship To addresses can use company names entered specifically for them if necessary.
1.1.12.1.4. Address
Contains two lines for of the primary address for the customer, as well as the city, state and zip code. An unlimited number of Bill To, Ship To, and Contact addresses can be entered on their respective tabs.
1.1.12.1.5. Country
Contains the country of the customer, if necessary.
1.1.12.1.6. Phone
Contains the primary phone of the customer. Other numbers can be entered for Bill Tos, Ship Tos, and Contacts.
1.1.12.1.7. Fax
Contains the customer’s fax number. The fax number used to send statements, invoices or other documents to the customer via a fax server must be entered in the Statement/Document Email or Fax field below.
1.1.12.1.8. Contact
The primary customer contact name. An unlimited number of additional contacts can be entered on the Contacts tab. Because the Contact tab contains a number of addition fields related to a contact, you may wish to add this contact there as well. The entry of a contact in this field does not automatically create that contact on the Contacts tab.
1.1.12.1.9. Contact Email
The email address for the contact above. 
1.1.12.1.10. Sort Field
This field can be used for any user defined purpose, such as characters that could be used to sort customers on reports into an order that is more logical than the Company name. For example, The Acme Company might have a sort field of ACMECO so that it would be alphabetically placed with A’s rather than T’s. But it could be used to group or sort customers for any reporting purpose. The sort field can also be used to locate customers in the pick list. 
1.1.12.1.11. Def Route ID
The default delivery route for the customer. Routes are created and maintained on the Edit Routes screen on the Edit menu of the Admin module.  
1.1.12.1.12. Statement/Document Email or Fax
Enter either the email address or fax number to be used if any of the customer forms are designated to be sent via email or fax on the Forms tab.
1.1.12.1.13. Website
Enter a website in the form of WWW.xxxx.xxx. Double-click on the field to open that site in your default browser. 
1.1.12.1.14. Active
A customer must be checked as active to have orders entered for them. A customer may have an outstanding AR balance owed but not be Active. Customers that are not Active are colored orange in a customer pick list and the lookup can be checked to list Active Only.
1.1.12.1.15. Taxable
If checked, sales tax will be charged on all items on invoices, based on the above tax authority, when the item sold is also taxable according to the item master. Items that are taxable on that sale have a check in the Tax column on the order Detail tab. The check can be removed on items that are not taxable on that sale. The Taxable box should usually be checked on a customer that is predominately taxable even if they have a tax exemption. If a customer is never taxable then it should not be checked. Non-taxable customers may also be assigned zero tax rate tax authorities. 
1.1.12.1.16. On Account
This must be checked if the customer is to be allowed to charge orders and be invoiced. If not, then the customer is assumed to be “cash” and payment must be received with any order that has allocated quantities.
1.1.12.1.17. Statement
If checked, the customer will be included in the Print Statements run.
1.1.12.1.18. Late Charges
If checked the customer will be eligible to be charged late charges for late payment of invoices. Late Charges are setup on the System Defaults Late Charges tab on the AR tab. Late charges are created in the Accounts Receivable module with the Generate Late Charges program on the Invoices menu.
1.1.12.1.19. Auto xmit Statements
If checked, will send the customer’s statement via the email address in the Statement/Document Email or Fax field, assuming the customer has the Statement box checked.
1.1.12.1.20. Credit Hold
Check box if you want to place a hold on the selected customer’s credit.  The credit hold prevents you from creating an order for the customer.  The hold can be overridden with the AR Hold Manager Override password from the System Defaults OE tab.
1.1.12.1.21. Default “Give Change” in OE
When a customer tenders more than the amount due in order entry on the Shipping/Payment tab the extra amount can either be applied to the customer's account as an unapplied payment or it can be returned to the customer as change. Checking this box defaults the customer to give them change. That can be overridden on the order by the user if necessary.  
1.1.12.1.22. AR Days late
This field determines the number of days past the net due date that a customer's oldest unpaid invoice may go before a hoild is placed on the account. Once a customer invoice reaches that number of days, new orders entered will require a manager override to allocate goods on the order. The number of days can be specific for each customer. Leave this field blank or enter  an extremely large number to disable holds for this customer.
1.1.12.1.23. Pre-Bill
This option only appears because the pre-billing option has been turned on by BCR for your system. Pre-billing invoices customers for orders before they are allocated. In other words the customer requires an invoice for all goods on an order immediately. See the documentation on pre-billing for further information on this function. NOTE: When a customer has Pre-Bill checked ALL orders for that customer will be pre-billed. If the pre-billing is a onetime event you will want to check this option, do the pre-billing, and then uncheck the option.
1.1.12.1.24.  (OE Detail Req Field Name)
The name of this field is user defined by your company. This checkbox only appears if a name has been entered in the OE Detail Req Field Name in System Defaults on the User Defined Fields tab of the OE tab. This also causes a column by that name to appear on the Detail tab or order entry. If this box is checked then when orders for this customer are entered the system will require an entry in this column for every item entered. If the box is not checked then any entry in that column will be optional for this customer. 
1.1.12.1.25. OE F12 By Ship To
In order entry on the Detail tab, pressing F12 will display a subscreen listing all of the items the customer has purchase in the past, what they paid, how many they purchased, etc. If this box is checked then the F12 for this customer will only display the items purchased for shipment to the ship to address on that order’s Header tab.
1.1.12.1.26. Req Ship To
If this box is checked than users must select a ship to every time they create an order for this customer. If not checked the system will automatically select either the default ship to, or if there is no default ship to, the primary customer name and address are chosen. In either case the user can override the selection.
1.1.12.1.27. Req Payment
If this box is checked then the user will be prompted to ask for payment before a pick ticket for an order with allocated goods can be printed. This box is usually checked for customers that pick up goods and are COD. Even though they are COD you should check the On Account box.
1.1.12.1.28. No BOs
If checked this indicated that the customer does not accept back orders. After the initial shipment on an order the order will automatically be closed and items or quantities not shipped on the order will not show as backordered quantities. Customers with this box checked will have the No Backorders box checked on the Header tab of orders in order entry and it cannot be overridden. If the customer is not check for No BOs here an individual order can still be checked as No Backorder in order entry.  
1.1.12.1.29. Ship Complete Only
If checked then all orders for this customer must have all quantities allocated before a pick ticket will print. Either the item that cannot be shipped must be deleted or its order quantity reduced. Otherwise the order will not print until sufficient stock is available to allocate all items and quantities. The Ship Complete box will be checked on the Header tab of the order but can be unchecked to allow printing. The box can also be checked on the order Header tab if the customer option is not checked.
1.1.12.2. Sales Options
1.1.12.2.1. Tax Authority
Choose the tax authority from the dropdown that should be used for most sales to this customer. Tax authorities are created and maintained in Administration module with the Edit Sales Tax Table program on the Edit menu. A tax authority can also be assigned to each customer ship to on the Ship To tab and overridden in an order on the Header tab. 
1.1.12.2.2. Tax ID
This field is typically used to store the customer’s state sales tax exemption certificate number. This is for information purposes only and does not affect the percentage of sales tax charged. If anything is entered in this field then the On File? checkbox appears.
1.1.12.2.3. On File?
This checkbox only appears because something has been entered in the Tax ID field. If the Tax Form Warning dropdown in System Defaults on the Doc#/Misc tab of the OE tab has been set to anything but Don’t Warn User, then the system will determine if this box has not been checked and, if not, it will either warn the user at order entry or prohibit the user from taking an order for this customer, depending on the setting of the dropdown. The optional image scan button to the right can be used to scan a tax document into the system.
1.1.12.2.4. Tax Exemption Date
The Tax Exemption Date if for information purposes and may store the date that the form was effective, or the date that it was filed with you, or any other date relevant to the taxing authority.
1.1.12.2.5. Tax Expire Date
The Tax Expire Date is typically the date that the exemption certificate expires. If the Tax Form Warning dropdown in System Defaults on the Doc#/Misc tab of the OE tab has been set to anything but Don’t Warn User, then the system will determine if this date has passed and if it has, it will either warn the user at order entry, or prohibit the user from taking an order for this customer, depending on the dropdown setting. 
1.1.12.2.6. Type of Exemption
This field is for information purposes and can be used to store exemption types like RESALE or NON-PROFIT.
1.1.12.2.7. Terms
Select the customer payment and early payment discount terms from this dropdown.  Terms are created and maintained in the Administration module using the Edit Customer Terms program on the File menu. Terms can be overridden in order entry on the Header tab. 
1.1.12.2.8. Price List Code
Select a default price list for this customer.  Price lists allow you to replicate pricing schedules (BLANK and A through E) as many times as necessary for your specific business needs.  You may create several general price lists that can be applicable to many customers, and/or specific price lists related to catalogs or customer contracts.  If the price list field is left blank, the standard price list in the item master is used.
1.1.12.2.9. Break Out Pricing
This selection relates to the additional charge for an Add On Item (the name of this field may be changed in the system defaults IP tab) that is setup in the Item master edit screen.  If this box is checked, the additional item and its price will appear as a separate line on Order Entry documents.  If this box is not checked,  the additional item and charge will be rolled into the master item's price on one line on Order Entry documents.  The additional item might be an installation charge or any other item, tangible or intangible,  appropriate to the master item.  The additional charge is determined by the price of the add on item in its own item record.  
1.1.12.2.10. Price Code
Enter a price code from BLANK, and A to E.  This corresponds to the price levels in the Item master file or, if used, the price list. A customer set as “B” will use the B level in the item master and in every price list to which they are assigned. Note that the names of price levels (Blank, A, B, etc.) may be changed in System Defaults and so may be different for your company.
1.1.12.2.11. Credit Limit
In whole dollars, determines the total amount that a customer can owe before orders are automatically placed on credit hold. The total amount “owed” is determined by the Cr Limit Method. The Credit Limit can be overridden in order entry by a manager with the AR Hold Manager Override password set in System Defaults on the OE tab.
1.1.12.2.12. Cr Limit Method
The Cr Limit Method determines when a customer has exceeded their Credit Limit setting. The dropdown options range from just the total of unpaid invoices posted to accounts receivable to the total of all unpaid invoices and orders, including order quantities that have not been allocated to ship.  
1.1.12.2.13. Payment Method
Select the customer’s default Payment Method from the dropdown. Payment Methods are created and maintained with the Edit Payment Methods program on the Edit menu in the Administration module. The Payment Method selected for the customer will be the default on the Shipping/Payment tab in order entry.  
1.1.12.2.14. Catalog
This field can be used to store a designated catalog for a customer or any information about the customer that you might want to report on or use to filter or categorize customers in reporting.
1.1.12.2.15. Categories
This field might be used for information related to the Catalog field but can be used to store any customer information for reporting purposes. This field is NOT for the item pricing categories. That field is located on the Pricing tab of Edit Customers. 
1.1.12.2.16. Credit Card
This is a legacy field. Storing unsecured credit card information is not a good business practice. This field should not be used for that purpose.
1.1.12.2.17. Expires
This is a legacy field. Storing unsecured credit card information is not a good business practice. This field should not be used for that purpose.
1.1.12.2.18. Security Code
 This is a legacy field. Storing unsecured credit card information is not a good business practice. This field should not be used for that purpose.
1.1.12.2.19.  (Primary User Defined Field 3)
The name of this field has been user defined by your company. Refer to your company documentation.
1.1.12.2.20.  (User Defined Date Field)
The name of this field has been user defined by your company. This field requires the entry of a date. Refer to your company documentation.
1.1.12.2.21. Source
Select a customer/order source from the dropdown. Sources are created and maintained in the Edit Order Sources program on the Edit menu in the Administration module. The Source can be overridden on the Header tab in order entry and used to sort and filter reports.
1.1.12.2.22.  (Primary User Defined Field 1)
The name of this field has been user defined by your company. Refer to your company documentation.
1.1.12.2.23.  (Primary User Defined Field 2)
The name of this field has been user defined by your company. Refer to your company documentation.
1.1.12.3. Shipping / Regional Options
1.1.12.3.1. Shipping Options
1.1.12.3.1.1. OE Inventory Allocation
This function allows a company to take orders for product but not allocate inventory to the order.  There are three settings available:  (1) Manual - Quantities ordered are not allocated (0) and the user must manually set the allocation quantity.  (2) Automatic With Override – Quantity ordered is automatically allocated (up to the quantity available) but the user can reduce the quantity.  (3) Automatic Without Override - Quantity ordered is automatically allocated (up to the quantity available) and the user cannot change the quantity.  Automatic Without Override basically turns off the inventory allocation function.
1.1.12.3.1.2. Tiered Freight Code
Tiered freight is an option to discount or establish freight charges to the customer based on the sales dollar value of a shipment.  Tiered Freight Codes are created and maintained in the Edit Tiered Freight program on the Edit menu in the Administration module. The code appears on the Shipping/Payment tab in order entry as the Tiered Freight Calculation and can be overridden there.
1.1.12.3.1.3. Shipping Method
Enter the preferred shipping method for this account. This is the shipping method that will pre-fill on orders for this customer. Valid shipping methods are created at Administration>Edit>Edit Shipping Methods. 
1.1.12.3.1.4. Exclusive Shipping Method
Check this option if the shipping method (above) is the only method accepted by this customer.
1.1.12.3.1.5. Collect Shipping Account Number
Enter the collect account number for the customer’s preferred shipping method. This number will appear in order entry and on shipping documents if the form is designed to show it.
1.1.12.3.2. Regional Options
1.1.12.3.2.1. Salesperson
Enter a valid salesperson to be assigned this account. Every customer should have a valid salesperson assigned. Use a generic such as HOUSE if salespeople are not assigned customers. Valid entries are defined in Administration>File>Edit Sales Staff.
1.1.12.3.2.2. Region
This field is not validated and can be used for any purpose, such as sorting for sales reporting.
1.1.12.3.2.3. Lock in OE
Checking this option prevents anyone entering an order for this customer from changing the salesperson assigned above.
1.1.12.3.2.4. Office Location
Office locations are not the same as warehouses. Typically they are unique sales locations that may not have warehouses. Assign a location if this customer typically buys at that one location. If you need to add valid office locations you can do so using the button to the right of Multiple Office Locations in the Administration>System>Set System Defaults on the OE>Switches>General tab.  
1.1.12.3.2.5. Remove
Click this button to blank the entry to the left.
1.1.12.3.2.6. Warehouse Location
Assign a warehouse to a customer if that customer typically orders goods delivered from that warehouse. Warehouses are created in the Administration>System>Set System Defaults on the IP>Misc tab by clicking the Edit Warehouses button.  
1.1.12.3.2.7. Remove
Click this button to blank the entry to the left.
1.1.12.4. Misc Options
1.1.12.4.1. Report Group
The Report Group can be used to categorize customers in any way necessary for reporting purposes. Numerous other report category types can be defined using User Defined fields.
1.1.12.4.2. PO and Aux Reqs
Select the purchase order number and auxiliary “Aux” number requirements of this customer . The label for the auxiliary number is user defined.
1.1.12.4.3. Duplicate PO Handling
The system can compare the PO# entered on an order to previous number entered on orders for this customer and WARN the user entering the order that the PO# entered matches another order for that customer in the past. Or it can PROHIBIT the user from using that PO#.
1.1.12.4.4. Default Auxiliary
The auxiliary number field has a user defined label. Examples might be DEPT# or JOB NAME. The Auxiliary Number Description label is defined in Administration>System>Set System Defaults on the OE main tab. If the customer has a default DEPT#, JOB NAME, etc., such as NONE or MAINT, enter that here.
1.1.12.4.5. Default PO #
If the customer has a default PO # to be used when no specific number is given for an order, enter it here.
1.1.12.4.6. AR Method
If a customer is set to Balance Forward old, unpaid invoices will be summarized as balances for the financial periods when AR Month End Processing (Accounts Receivable>General) is run to update the AR period. If they are set to Open Item then invoices are not summarized. The typical setting is Open Item.
1.1.12.4.6.1. Open Item
1.1.12.4.6.2. Balance Forward
1.1.12.4.7. Default Order Type
Valid order types are setup using Administration>Edit>Edit Order Types. The order type can be assigned at the order level and might be used, for example, to segregate repair orders from stock orders. Set the default order type for this customer here.
1.1.12.4.8. Add User
The ID of the user that created this customer record. This field cannot be edited.
1.1.12.4.9. Upd User
The ID of the user that most recently made any change to this customer record. This field cannot be edited.
1.1.12.4.10. Start Date
This is the date the record was originally created though the date can be edited.
1.1.13. Bill To
1.1.13.1. (grid)
1.1.13.2. Default Bill-To Address
1.1.13.3. Add Default
1.1.13.4. (browser)
1.1.13.5. Bill To Address
1.1.13.5.1. Description
1.1.13.5.2. Name
1.1.13.5.3. Address
1.1.13.5.4. Country
1.1.13.5.5. Email
1.1.13.5.6. Phone Number
1.1.13.6. Other
1.1.13.6.1. Additional Information
1.1.13.6.2. Contact
1.1.13.6.3. Location Code
1.1.13.6.4. Credit Card #
1.1.13.6.5. Expires
1.1.13.6.6. Security Code
1.1.13.7. EDI (???)
1.1.13.7.1. Qualifier
1.1.13.7.2. ID
1.1.13.7.3. Communication Address
1.1.13.7.4. User Name
1.1.13.7.5. Password
1.1.14. Ship To
1.1.14.1. Find
1.1.14.2. Default Ship To Address
1.1.14.3. Collect Shipping Account Number
1.1.14.4. (grid)
1.1.14.5. Edit
1.1.14.5.1. Ship To Address
1.1.14.5.1.1. Description
1.1.14.5.1.2. Name
1.1.14.5.1.3. Address
1.1.14.5.1.4. Country
1.1.14.5.2. Default Bill To
1.1.14.5.3. Packing Slip
1.1.14.5.4. Def Salesman
1.1.14.5.5. Route ID
1.1.14.5.6. Sequence
1.1.14.5.7. Price Level
1.1.14.5.7.1. Price Level
1.1.14.5.7.2. Override Customer
1.1.14.5.7.3. Price List
1.1.14.5.8. Contact Info
1.1.14.5.8.1. Contact
1.1.14.5.8.2. Phone
1.1.14.5.8.3. Fax
1.1.14.5.8.4. Email
1.1.14.5.9. EDI Qualifier
1.1.14.5.10. EDI ID
1.1.14.5.11. Other
1.1.14.5.11.1. Tax Authority
1.1.14.5.11.2. Ship Meth
1.1.14.5.11.3. Concept
1.1.14.5.11.4. Type
1.1.14.5.11.5. Add’l Infor
1.1.14.5.11.6. CC #
1.1.14.5.11.7. Expires
1.1.14.5.11.8. Security Code
1.1.14.5.11.9. Office Location 1
1.1.14.5.11.10. Warehouse Location 1
1.1.14.5.11.11. Clear Locations
1.1.14.6. Notes
1.1.15. Additional Info
1.1.15.1. (Secondary User Defined Fields 1-15)
1.1.16. Contacts
1.1.16.1. (grid)
1.1.16.2. Contact Notes
1.1.16.3. Other Phone Numbers
1.1.16.3.1. Location
1.1.16.3.2. Type
1.1.16.3.3. Phone
1.1.16.3.4. Add
1.1.16.3.5. Delete
1.1.16.4. Contact Information
1.1.16.4.1. Last
1.1.16.4.2. First
1.1.16.4.3. Title
1.1.16.4.4. Address
1.1.16.4.5. Phone
1.1.16.4.6. Ext
1.1.16.4.7. Fax
1.1.16.4.8. Alt. Phone
1.1.16.4.9. E-Mail
1.1.16.4.10. E-Mail 2Alt. Email
1.1.16.4.11. Credit Card #
1.1.16.4.12. Expires
1.1.16.4.13. Sec Code
1.1.16.4.14. Hide this contact in OE
1.1.17. Pricing
This table lists the item price categories, their discount percent, and the price level used. You cannot change the table directly. The table is maintained via the Category Code, Discount Percent and Price Level fields below it. It may also be filled by assigning a Customer Pricing Group from the Pricing Matrix.
1.1.17.1.  (grid)
1.1.17.2. Category Code
Use this dropdown to enter a new Category Code in the grid above. Valid categories are created at Administration>Edit>Edit Pricing Categories. Individual categories cannot be added to a customer assigned a matrix Customer Pricing Group. 
1.1.17.3. Discount Percent
Enter the discount that is to be given this customer on the items assigned that category. The discount will be applied to the Price Level to the right. A Discount Percent of “5” would mean that the level to the right will be multiplied by .95.
1.1.17.4. Price Level
Select the Price Level from this dropdown that the Discount Percent is to be applied to.  “N/A” means that the level used will be the Price Code on the Edit>Sales Options tab. You can also specify a “discount” on the standard cost or the last (most recent) cost. Usually these would be cost-plus discounts so for a 5  percent markup (1.05 multiplier) you would enter “-5”.
1.1.17.5. Pricing Matrix
1.1.17.5.1. Customer Pricing Group
Select a Pricing Matrix group from the dropdown. Groups are created in the pricing matrix, which can be accessed from the button below or by the Administration Edit menu. Setting a matrix group will overwrite any prior category discounts. No additional changes to the customer setup will be permitted. Use the erase button to the right of the dropdown if you wish to remove matrix pricing from the customer.
1.1.17.5.2. Pricing Matrix
1.1.17.6. Copy From Another Customer
You can establish a category pricing table setup in another customer and copy the setup from that customer by entering the customer ID here. While this has an advantage similar to the pricing matrix, unlike the matrix, subsequent changes to the "copy from" customer will not be reflected in the "copy to" customer. After selecting the "copy from" customer you must select a Copy Method and click the Copy button to fill the table. The "copy from" customer is not retained once you exit the customer record. One advantage using this method over the matrix is that you can then make changes to the categories, discounts, and price levels, that will be unique to that customer. 
1.1.17.6.1. Lookup
1.1.17.6.2. Copy Method
1.1.17.6.2.1. Replace All Codes
1.1.17.6.2.2. Add New Codes
1.1.17.6.3. Copy
1.1.18. History
1.1.18.1. (grid)
1.1.19. Notes
1.1.19.1. (grid)
1.1.19.1.1. Pri
1.1.19.1.2. St
1.1.19.1.3. Date
1.1.19.1.4. Time
1.1.19.1.5. User
1.1.19.1.6. Review User
1.1.19.1.7. Date
1.1.19.1.8. Time
1.1.19.1.9. Reviewed?
1.1.19.2. (text box)
1.1.19.3. Order By
1.1.19.3.1. Priority Date
1.1.19.3.2. Review User
1.1.19.4. Order Entry Pop-Up User Message
1.1.19.5. Order Entry Document Message
1.1.19.5.1. Message Number
1.1.19.5.2. … (browser)
1.1.19.6. Customer Notes
1.1.20. Forms
1.1.20.1. Default Documents
1.1.20.1.1. Quotes
1.1.20.1.2. Copies Override
1.1.20.1.3. Transmit Options (Defaults)
1.1.20.1.3.1. Print
1.1.20.1.3.2. Email 
1.1.20.1.3.3. Fax
1.1.20.1.3.4. Email Salesperson
1.1.20.1.4. Orders/Confirmations
1.1.20.1.5. Copies Override
1.1.20.1.6. Transmit Options (Defaults) Quotes
1.1.20.1.6.1. Print
1.1.20.1.6.2. Email 
1.1.20.1.6.3. Fax
1.1.20.1.6.4. Email Salesperson
1.1.20.1.7. Invoices
1.1.20.1.8. Copies Override
1.1.20.1.9. Transmit Options (Defaults)
1.1.20.1.9.1. Print
1.1.20.1.9.2. Email 
1.1.20.1.9.3. Fax
1.1.20.1.9.4. Email Salesperson
1.1.20.1.10. Credit Notes
1.1.20.1.11. Copies Override
1.1.20.1.12. Transmit Options (Defaults)
1.1.20.1.12.1. Print
1.1.20.1.12.2. Email 
1.1.20.1.12.3. Fax
1.1.20.1.12.4. Email Salesperson
1.1.20.1.13. RMAs
1.1.20.1.14. Copies Override
1.1.20.1.15. Transmit Options (Defaults)
1.1.20.1.15.1. Print
1.1.20.1.15.2. Email 
1.1.20.1.15.3. Fax
1.1.20.1.15.4. Email Salesperson
1.1.20.1.16. Pick Tickets
1.1.20.1.17. Copies Override
1.1.20.1.18. Transmit Options (Defaults)
1.1.20.1.18.1. Print
1.1.20.1.18.2. Email 
1.1.20.1.18.3. Fax
1.1.20.1.18.4. Email Salesperson
1.1.20.1.19. Packing Slips
1.1.20.1.20. A/R Statements
1.1.20.2. Add Scanned PO or Tax Information to E-Mailed or Faxed Documents
1.1.20.3. Add Scanned Packing Slip to E-mailed or Faxed Documents
1.1.21. Items
1.1.21.1. Item to add to all new Orders
Will add this item automatically to every new order created for this customer. Enter an item code or use the browse button (...) to the right to open a lookup box.
1.1.21.2. … (browser)
1.1.21.3. Find
1.1.21.4. Lookup/List by
1.1.21.4.1. Item Number
1.1.21.4.2. Customer Item Number
1.1.21.5. Item
1.1.21.6. Item Description
1.1.21.7. Customer Item Number
1.1.21.8. Customer Item Description
1.1.21.9. Picking Location
1.1.21.10. Rebate %
1.1.21.11. Rebate $
1.1.21.12. Box Qty
1.1.22. Month End
1.1.22.1. Document Printing With Statement
1.1.23. E-Commerce
1.1.23.1. E-Commerce ID
1.1.23.2. Customer URL
1.1.24. EDI
1.1.24.1. Qualifier
1.1.24.2. ID
1.1.24.3. EDI Version
1.1.24.4. Field Separator
1.1.24.5. Line Separator
1.1.24.6. VAN ID
1.1.24.7. VAN Qualifier
1.1.24.8. Passport/SAP ID
1.1.25. FTP Information
1.1.25.1. FTP Site
1.1.25.2. FTP Login
1.1.25.3. FTP Password
1.1.25.4. FTP Directory
1.2. Edit Vendors
1.2.1. OK
1.2.2. Add
1.2.3. Delete
1.2.4. Label
1.2.5. Pick List
1.2.6. Help
1.2.7. Previous
1.2.8. Next
1.2.9. Verify Address
1.2.10. List
1.2.10.1. (grid)
1.2.10.2. Order
1.2.10.2.1. ID
1.2.10.2.2. Company
1.2.10.2.3. Phone
1.2.10.2.4. Sort Field
1.2.10.3. Find
1.2.11. Edit
1.2.11.1. Vendor Address
1.2.11.1.1. ID
1.2.11.1.2. Company
1.2.11.1.3. Address
1.2.11.1.4. Country
1.2.11.1.5. Contact
1.2.11.1.6. Phone
1.2.11.1.7. Fax
1.2.11.1.8. Start Date
1.2.11.1.9. E-Mail Address
1.2.11.1.10. Web Address (URL)
1.2.11.1.11. Certification
1.2.11.1.12. Cert. Exp. Date
1.2.11.2. Other
1.2.11.2.1. Federal Tax ID
1.2.11.2.2. G/L Account
1.2.11.2.3. Distribution Method
1.2.11.2.4. Terms
1.2.11.2.5. Our Account #
1.2.11.2.6. Purchasing Agent
1.2.11.2.7. Sortfield
1.2.11.2.8. Use Dist. Vend Terms
1.2.11.2.9. 1099
1.2.11.2.10. W9 On File?
1.2.11.2.11. One Time Vendor
1.2.11.2.12. OE PO Successive Vendor
1.2.11.3. Ordering Information
1.2.11.3.1. Auto Create POs
1.2.11.3.2. Minimum P.O. $
1.2.11.3.3. Free Freight Minimum $
1.2.11.3.4. Minimum P.O. Weight
1.2.11.3.5. Minimum Direct Ship $
1.2.11.3.6. Review Days
1.2.11.4. Cost Factor
1.2.11.5. Print Method Defaults
1.2.11.5.1. Print
1.2.11.5.2. E-Mail
1.2.11.5.3. Fax
1.2.11.6. User Defined
1.2.11.6.1. (UD 1)
1.2.11.6.2. (UD 2)
1.2.11.6.3. (UD date)
1.2.11.7. Notes
1.2.11.8. Currency
1.2.11.8.1. … (browser)
1.2.11.9. Qty Discounts in Currency
1.2.12. Remit To
1.2.12.1. (grid)
1.2.12.2. Remit To Address
1.2.12.2.1. Description
1.2.12.2.2. Name
1.2.12.2.3. Address
1.2.12.2.4. Country
1.2.12.3. Other
1.2.12.3.1. Our Acct ID
1.2.12.3.2. Additional Information
1.2.12.4. Add Default
1.2.12.5. EDI
1.2.12.5.1. Communication Address
1.2.12.5.2. User Name
1.2.12.5.3. Password
1.2.12.5.4. Payment Transmit Email Address
1.2.13. Contacts
1.2.13.1. (Contacts grid)
1.2.13.2. Contact Notes
1.2.13.3. (Other Phone Numbers grid)
1.2.13.3.1. Location
1.2.13.3.2. Type
1.2.13.3.3. Phone
1.2.13.4. Add
1.2.13.5. Delete
1.2.13.6. Contact Information
1.2.13.6.1. Last
1.2.13.6.2. First
1.2.13.6.3. Title
1.2.13.6.4. Phone
1.2.13.6.5. Ext.
1.2.13.6.6. Fax
1.2.13.6.7. Cell/Home Phone
1.2.13.6.8. E-Mail
1.2.13.6.9. E-Mail 2
1.2.14. Notes
1.2.14.1. (grid)
1.2.14.1.1. Pri
1.2.14.1.2. St
1.2.14.1.3. Date
1.2.14.1.4. Time
1.2.14.1.5. User
1.2.14.1.6. Review User
1.2.14.1.7. Date
1.2.14.1.8. Time
1.2.14.1.9. Reviewed?
1.2.14.2. (text box)
1.2.14.3. Order By
1.2.14.3.1. Priority Date
1.2.14.3.2. Review User
1.2.15. Items
1.2.15.1. Lookup/List by
1.2.15.1.1. Item Number
1.2.15.1.2. Vendor Item Number
1.2.15.2. Search
1.2.15.3. (grid)
1.2.15.4. Lookup
1.2.16. EDI
1.2.16.1. EDI
1.2.16.1.1. Vendor Qualifier
1.2.16.1.2. Version
1.2.16.1.3. VAN Qualifier
1.2.16.1.4. Vendor ID
1.2.16.1.5. Passport/SAP ID
1.2.16.1.6. VAN ID
1.2.16.1.7. Field Separator
1.2.16.1.8. Line Separator
1.2.16.2. FTP Information
1.2.16.2.1. FTP Site
1.2.16.2.2. FTP Login
1.2.16.2.3. FTP Password
1.2.16.2.4. FTP Directory
1.2.16.3. Payment Email Address
1.2.16.4. Payment Transmit Email Form (AP…)
1.2.17. Forms
1.2.17.1. Default PO (PO… or PU…)
1.2.18. Statistics
1.2.19. Vend/Class Discount
1.2.19.1. Default Values When Selecting Classes
1.2.19.1.1. Default Discount
1.2.19.1.2. Default Basis
1.2.19.2. Change Basis
1.2.19.3. (grid)
1.2.19.3.1. Discount %
1.2.19.4. Select
1.2.19.5. De-Select
1.2.19.6. (Available Classes grid)
1.3. Edit Sales Staff
1.3.1. (grid)
1.3.1.1. Staff
1.3.1.2. Name
1.3.1.3. Region
1.3.1.4. CommDesc
1.3.1.5. Cost Factor
1.3.1.6. Margin Factor
1.3.2. E-Mail Address or Fax Number
1.3.3. Straight Commission (box displayed when Commission Method is Straight Commission)
1.3.3.1. Commission %
1.3.3.2. Minimum
1.3.4. Tiered Commission (box displayed when Commission Method is Tiered Rates)
1.3.4.1. (grid)
1.3.4.1.1. Min
1.3.4.1.2. Max
1.3.4.1.3. Commission %
1.3.4.2. Sum Commission Within Each Applicable Tier
1.3.4.3. Add
1.3.4.4. Delete
1.3.5. by Item & Class (box displayed when Commission Method is By Item & Class)
1.3.5.1. (grid)
1.3.5.1.1. Item
1.3.5.1.2. Class
1.3.5.1.3. % (base)
1.3.5.1.4. % (price A)
1.3.5.1.5. % (price B)
1.3.5.1.6. % (price C)
1.3.5.1.7. % (price D)
1.3.5.1.8. % (price E)
1.3.5.2. Find Item
1.3.5.3. Add
1.3.5.4. Delete
1.3.5.5. Pick List
1.3.6. Inside Salesperson (Entered By)
1.3.7. Commission
1.3.7.1. Pay Commission
1.3.7.2. Commission Method
1.3.7.2.1. Straight Commission
1.3.7.2.2. Tiered Rates
1.3.7.2.3. By Item & Class
1.3.7.3. AR Options
1.3.7.3.1. Invoices in AR First Commission only if paid in
1.3.7.3.2. Days
1.3.7.4. Based On
1.3.8. Close
1.3.9. Add
1.3.10. Delete
1.3.11. Commission Rpt
1.3.12. Sales Staff Setup
1.3.12.1. Copy From
1.3.12.2. Copy To
1.3.12.3. Copy
1.3.13. Commission Setup
1.3.13.1. Create new items when necessary
1.3.13.2. Copy
1.4. Edit Fiscal Periods
1.4.1. Select Year
1.4.1.1. Fiscal Year
1.4.2. (grid)
1.4.2.1. Pd
1.4.2.2. Start
1.4.2.3. End
1.4.3. Close
1.4.4. Close Period
1.4.5. Complete Dates
1.5. Edit Chart Of Accounts
1.5.1. OK
1.5.2. Add
1.5.3. Delete
1.5.4. Replicate
1.5.5. Pick List
1.5.6. Previous
1.5.7. Next
1.5.8. List
1.5.8.1. (grid)
1.5.8.2. Order
1.5.8.2.1. Acct#
1.5.8.2.2. Name
1.5.8.2.3. Type
1.5.8.3. Search
1.5.9. Edit
1.5.9.1. Account Detail
1.5.9.1.1. Account
1.5.9.1.2. Description
1.5.9.1.3. Type
1.5.9.1.4. Class
1.5.9.1.5. Budget Cat
1.5.9.1.6. Parent
1.5.9.1.7. Beginning Balance
1.5.9.1.7.1. Debit
1.5.9.1.7.2. Credit
1.5.9.1.8. Used In
1.5.9.1.8.1. AP
1.5.9.1.8.2. AR
1.5.9.1.8.3. FA
1.5.9.1.8.4. IP
1.5.9.1.8.5. PR
1.6. Edit Items
1.6.1. OK
1.6.2. Add
1.6.3. Delete
1.6.4. Pick List
1.6.5. Previous
1.6.6. Next
1.6.7. Vendor Cat
1.6.8. Toggle IQA
Clicking this button will alternately turn on and off the Item Quick Add screen on the Edit tab. The IQA screen is an abbreviated screen displaying fields most commonly filled when adding new items.
1.6.9. List
1.6.9.1. (grid)
1.6.9.2. Order
The field selected will determine the sort order of the item list to the left and the order that the Prev and Next buttons step through the table from any tab. If you are using the Description order and go to the Pricing tab of an item then the Next button will step to the Pricing tab of the next item in description order. The order field selected determines which field the Find field will search in. All fields search from left to right with the exception of the Multi Word, which will search for any string of characters in the item description.  
1.6.9.2.1. Item#
1.6.9.2.2. Description
1.6.9.2.3. Auxiliary #
1.6.9.2.4. Alt Code
1.6.9.2.5. EQV Code
1.6.9.2.6. Customer ID
1.6.9.2.7. Vendor ID
1.6.9.2.8. Class
1.6.9.2.9. UPC Code
1.6.9.2.10. Cycle Code
1.6.9.2.11. Mfg Item #
1.6.9.2.12. Manufacturer
1.6.9.2.13. Vendor Item #
1.6.9.2.14. Cust. Item
1.6.9.2.15. Multi Word
1.6.9.3. Find 
1.6.10. Edit
1.6.10.1. General
1.6.10.1.1. Item#
The Item# is the unique identifier for the item. No two items can have the same number. New items are typically given an identifier that is meaningful, such as a manufacturer’s model number or something devised using an in house naming scheme. The system can be set to assign a sequential number but a significant identifier is considered more useful. The Item# can be any combination of 21 alpha and numeric characters.
1.6.10.1.2. Desc
The item description can be up to 50 characters. Double click in this field to display a second description line Desc2 which can contain an additional 50 characters. Additional text can be attached to the item for various purposes in the Ext Desc tabs at the bottom of the Status tab. Remember that forms and reports do not automatically display fields and may need to be modified if the Desc2 field is not showing.
1.6.10.1.3. Vendor
This is the primary vendor for this item. The dropdown only lists vendors currently listed on the Vendors tab for the item, so the vendor must be added there first. The primary vendor may determine whether that item is considered in suggested purchase orders.
1.6.10.1.4. Item#
If the primary vendor has an item identifier that is different from the Item# it can be entered here. This field is mirrored on the Vendors tab.
1.6.10.1.5. Customer
This field is not frequently used other than possibly for a special workaround to meet a special need. When an item is purchased by a customer who has a special item ID that they use to identify the item, or a special description they use for the item, that can be entered on the Customers tab, which allows the entry of multiple customers for this purpose. Use the Customers tab instead of this field.
1.6.10.1.6. Item#
See above. This field is not mirrored on the Customers tab.
1.6.10.1.7. Mfr Name
The manufacturer name is a free form input field that can be used to identify the manufacturer (as opposed to the vendor) or for any use you might have where you want to be able to list and locate items in item lookup.
1.6.10.1.8. Mfr Item#
This field might be used to for an item identifier that is specific to the manufacturer and not the same as your or the vendor's ID. It can be used to list and locate items in item lookup. While its label suggests it is the ID used by the manufacturer entered in the Mfr Name field to its left, but it can be used for any identifier that would help to locate items.
1.6.10.1.9. Class
The dropdown only lists valid classes that have been setup at Administration>Edit>Edit Item Classes. Classes are used to group like items. They may represent items from one vendor or a subgroup of items from a vendor or similar items from multiple vendors. Classes are used throughout the system for reporting and to make mass changes to items.
1.6.10.1.10. Auxiliary Item#
This is a secondary identifier to the Item#. Any transaction entry field that calls for an Item# will also recognize an Auxiliary Item#. This field is frequently used for older item numbers when a vendor changes the identifier. The Change/Merge Item Number program (Administration>System) will give you the option to save the old Item# to the Auxiliary Item# so that the new item can be retrieved with either the old or new identifier.
1.6.10.1.11. Report Grp
This field can be used as an alternative sorting value for custom reports.
1.6.10.1.12.  (add on) Item
The label for this field can be set in System Defaults on the IP tab. The default label is "Installation Item #".  This item can be a tangible item or an intangible charge. It can be any item that is suggested, recommended, or required to be sold with the primary item. When the primary item is entered in order entry, the system will prompt the user to add the “add on item” or not. If the item is added and the customer break out pricing option is checked then the item will be displayed separately on the order screen. If not then the item is not listed and its price is rolled into the price of the primary item.  
1.6.10.1.13. Alt Code
An item can be assigned a single Alt Code. Like the Equiv Code (below) these codes are created by simply entering a new one in this field, so it is important to avoid accidently creating new codes with typos. Codes are groups of items unique to that code.  A code such as “HAMMER” might contain all of the items that are hammers. Unlike related and substitute items, however, that item cannot also be assigned to any other Alt Code groups such as “HANDTOOLS.” When an item is entered on the Detail tab in order entry you can view a list of other items assigned the same alt code will be listed in the Relation tab at the bottom of the screen.
1.6.10.1.14. … (browser)
Click this button to open a subscreen where you can see the assignments of existing alt codes. From this screen you can also add items quickly to specific codes.  
1.6.10.1.15. Cycle Code
The cycle code can be used to identify item groups that are to be cycle counted at the same time. It can be used in the Physical Inventory Count program to identify items with specific cycle codes that are to be counted.
1.6.10.1.16. UPC Code
This should be the primary UPC code for the item. This is the UPC that will be searched for if a barcode is scanned in sales order entry. UPC codes that are unique to another vendor of the same item can be saved on the Vendors tab but only this UPC will be recognized when scanning a barcode.
1.6.10.1.17. Equiv Code
An item can be assigned a single Equiv Code. Like the Alt Code (above) these codes are created by simply entering a new one in this field, so it is important to avoid accidently creating new codes with typos. Codes are groups of items unique to that code.  A code such as “HAMMER” might contain all of the items that are hammers. Unlike related and substitute items, however, that item cannot also be assigned to any other Equiv Code groups such as “HANDTOOLS.” When an item is entered on the Detail tab in order entry you can view a list of other items assigned the same equiv code will be listed in the Relation tab at the bottom of the screen.
1.6.10.1.18. Start Date
The date this item record was created. This date can be useful in reports when evaluating a product's sales performance.
1.6.10.1.19. Serial #s
Check this option if you wish to enable serial number tracking for this item. The Serial Numbers tab will be displayed at the bottom of the Status tab. Enabling serial number tracking will cause the system to prompt for a serial number when this item is received and/or sold. 
1.6.10.1.20. Lot #s
Check this option if you wish to enable lot tracking or pick (bin) location tracking for this item. The Lots/Pick Locs tab will be displayed at the bottom of the Status tab. Enabling lot/pick location tracking will cause the system to prompt for a serial number when this item is received and/or sold. 
1.6.10.1.21. Excl. from Margin Calcs
1.6.10.1.22. Edit User
This is the last user to edit any field in this record. This field cannot be edited. 
1.6.10.1.23. Size
These fields are for information purchases only.  They have no function in purchasing or sales.
1.6.10.1.23.1. Ln
1.6.10.1.23.2. Wd
1.6.10.1.23.3. Ht
1.6.10.1.23.4. Desc
1.6.10.1.24. Sales Taxes
Check each of the boxes that applies to this item. Since there is no national sales tax in the U.S. the “Fed” option will have no function but it would in Canada. Usually if an item is taxable in a state it will be in other authorities as well. The default setting would be to check all boxes. 
1.6.10.1.24.1. Taxable
1.6.10.1.24.2. Fed
1.6.10.1.24.3. State
1.6.10.1.24.4. Local
1.6.10.1.24.5. Municipal
1.6.10.2. User
The labels for these fields are user defined in Administration>System>Set System Defaults on the IP>User Defined tab.
1.6.10.2.1.  (user defined 1)
1.6.10.2.2. (user defined 2)
1.6.10.3. Picking Locations
1.6.10.3.1. Picking Sequence
If you use one or two picking locations or sequences for each item and only have one warehouse then you may choose to use this field and the 2nd Loc field beneath it rather than the Picking Location grid below it, which will handle multiple warehouses with multiple pick locations. The data for The Picking Sequence and 2nd Loc is stored in the ITEM table, which can make it easier to include in reports.    
1.6.10.3.2. 2nd Loc
If you use one or two picking locations or sequences for each item and only have one warehouse then you may choose to use this field and the Picking Sequence field above it rather than the Picking Location grid below it, which will handle multiple warehouses with multiple pick locations. The data for The Picking Sequence and 2nd Loc is stored in the ITEM table, which can make it easier to include in reports.   
1.6.10.3.3. By Warehouse
The warehouse or "All Locations" selected here determines what warehouse the entries in the Picking Location grid below apply to. If you only have one warehouse location and no more than two pick locations for any item then you would probably use the Picking Sequence and 2nd Loc above rather than this grid.
1.6.10.3.4.  (grid)
1.6.10.3.4.1. Picking Location
The warehouse or "All Locations" selected in the dropdown above determines what warehouse the entries in the Picking Location grid apply to. If you only have one warehouse location and no more than two pick locations for any item then you would probably use the Picking Sequence and 2nd Loc above rather than this grid.
1.6.10.3.4.2. Pri
You can use this field to indicate the priority of this picking location (e.g., 1,2,3,… or A,B,C,…). It can be used to sort the listing of pick locations on picking and receiving documents.
1.6.10.3.4.3. Desc
Might be used to describe the nature of the location, e.g., floor, shelf, or rack.
1.6.10.3.5. Pricing
This fields are displayed here for reference only and cannot be edited. You can edit them on the Pricing tab.
1.6.10.3.5.1.  (base)
1.6.10.3.5.2. (price A)
1.6.10.3.5.3. (price B)
1.6.10.3.5.4. (price C)
1.6.10.3.5.5. (price D)
1.6.10.3.5.6. (price E)
1.6.10.3.6. GL Accounts
1.6.10.3.6.1. Revenue
Every item must have a valid GL account assigned for sales revenue. It is usually the same as the default account assigned in System Defaults but need not be the same. Non-tangible items are frequently posted to different accounts. When an invoice is processed at End of Day the specific account assigned the item will be credited with the extended sales revenue dollars. Use the Pick List button to look up accounts if need be
1.6.10.3.6.2. Cost/Sales
Every stock or tangible item must have a valid GL account assigned for the COGS (cost of goods sold.) It is usually the same as the default account assigned in System Defaults but need not be the same. When an invoice is processed at End of Day the specific account assigned the item will be debited with the extended cost dollars. Use the Pick List button to look up accounts if need be. 
It an item is intangible or absolute miscellaneous this field is disabled (grayed).
1.6.10.3.6.3. Inventory
Every stock or tangible item must have a valid GL account assigned for the inventory asset. It is usually the same as the default account assigned in System Defaults but need not be the same. When an invoice is processed at End of Day the specific account assigned the item will be credited with the extended cost dollars. Use the Pick List button to look up accounts if need be. 
 It an item is intangible or absolute miscellaneous this field is disabled (grayed).
1.6.10.3.6.4.  (rental)
1.6.10.3.6.4.1. Rental?
Items that are for rent can be managed using the system rental functionality (see documentation). Check this option if this is a rental item. This option is mirrored on the Ordering tab. Revenue from items that are for rent is typically posted to a separate account from inventory sales revenue. Checking this box will allow you to enter or edit the Rent Rev account (below). 
1.6.10.3.6.4.2. Rent Rev
This field can only be used if the Rental? option (above) is checked. Enter or edit a rental revenue account as needed. 
1.6.10.3.6.5. Item Status
The item status determines whether an item is eligible to be sold or purchased. An Active status is the most common setting and means an item can be sold or purchased as needed. No Auto PO means that the item is active but will not be automatically added to POs that are generated by the system. Discontinued means that the item can be sold but cannot be purchased, i.e., you are closing the item out because you either no longer wish to carry it in stock or it is no longer available from the vendor. Discontinued items are displayed in blue on the List tab. Inactive gray on the List tab means that the item can neither be sold (even if you have stock on hand) nor purchased. Promotional only changes the color of the item displayed on the List tab to green. It can be used to tell users that you wish to actively promote this item or for any reason you might have to highlight it.
1.6.10.3.6.5.1. Active
1.6.10.3.6.5.2. No Auto PO
1.6.10.3.6.5.3. Discontinued
1.6.10.3.6.5.4. Inactive
1.6.10.3.6.5.5. Promotional
1.6.10.3.6.6. Ecommerce
1.6.10.3.6.7. OE Scanned
1.6.10.3.6.8. Picking Tier (WM)
1.6.11. Pricing
1.6.11.1. Price Levels
1.6.11.1.1. Price List
If this item is currently assigned to a price list you can maintain its price list prices directly from this screen. Use this dropdown to select a valid price list. If the item is not currently assigned to that price list you will be prompted to add it. Once a valid price list is selected, the item prices to the right will be the price list prices. Any changes there will be to the price list and not the normal pricing. If no price list has been selected then this field should list “Normal Price”.
1.6.11.1.2. … (browser)
Click this button to display a price list maintenance screen (Administration>Edit>Edit Price List) for the price list selected in the dropdown.
1.6.11.1.3. Based On
This dropdown select one of a variety of methods to calculate actual prices from the price basis. Prices may be calculated as discounts off of a “list” price (the top basis), a multiplier on Std. Cost, or an Actual dollar and cents price.  See documentation. 
1.6.11.1.4. Surcharge
Any amount entered here will automatically be added to the price of the item, regardless of how the price is determined.
1.6.11.1.5. Std. Cost
The standard cost is typically the replacement cost of the item, i.e., the next cost. How it is used in your system configuration will depend greatly on a number of other system settings. If cost markup pricing is used this is the cost that is used. The standard cost may be displayed on the order entry detail tab in addition to the cost used for inventory valuation. This field is mirrored on the Ordering tab.
1.6.11.1.6. Rental Price
If a rental item (an item with the Rental? option checked) is rented for a fixed amount, as opposed to increments, then the Rental Price entered here will be the fixed price. For example, the item is always rented for the weekend and only for a single weekend, instead of by the day or week for multiple days or weeks. Items rented for increments like days or weeks should be setup with a separate non-tangible rental fee for the rental period. See documentation.
1.6.11.1.7. Deposit
Any amount entered here will  produce a deposit required notice on the Shipping/Payment tab in order entry below the Tendered field. 
1.6.11.1.8. Update Prices
If you change the Based On or Price Basis fields using one of the import utilities or SQL rather than on the Pricing tab itself, Actual Price will not be automatically updated. Use this button to update the Actual Price using the new settings.
1.6.11.1.9. Retail Price
The price entered here is not part of a pricing scheme. It’s usually used to print on forms or labels at the request of customers, especially retail customers that expect to use this price as their price to their customers and require you to provide item labels.
1.6.11.1.10. Cost Factor
Any entry in this field other than 1 will adjust all of this item’s costs (Standard, Most Recent, Landed, and Average) by the factor entered. So if the current standard cost is $2 and the Cost Factor entered is 1.1 then the cost is immediately reset to $2.20. Note that Most Recent, Landed, and Average are calculated costs based on history. This method is not typically recommended for general cost increases from a vendor, which can be accomplished using other utilities.  
1.6.11.1.11. f-1
Clicking this button will fill the field below the Cost Factor (CF) with the reciprocal (R)  of the Cost Factor (i.e., 1/CF=R ). E.g., a Cost Factor of 2 produces a reciprocal of .5.
1.6.11.1.12.  (factor reciprocal)
See above.
1.6.11.1.13. Sales Factor
1.6.11.1.14. Minimum Price
The Minimum Price is automatically set to the Std Cost.  It can be set higher manually. If the Consider MINPRICE in Pricing Calculations option (System Defaults>OE>Pricing) is set then no pricing, automated or manual, can go below this amount for this item in order entry. If the option is not set then it is merely for reference.
1.6.11.1.15. %
This is the markup percent as a result of the Minimum Price (above).
1.6.11.2.  (Item Prices)
There are six system price levels for every item. Internally, or by default, they are known as base, A, B, C, D, and E. The labels that are displayed can be user defined in System Defaults (Administration>System>Set System Defaults>IP>Item Master). For each price level there are three fields, Qty Disc Applies, Price Basis, and Actual Price. If the Qty Disc Applies option is checked then that level also uses the Quantity Discounts in the lower left of the tab. NOTE: This option setting does not matter if the item is setup for unit of measure (UOM) pricing instead of quantity discounts. When setup, UOM pricing always applies to all levels for that item.
The Price Basis functions in concert with the Based On dropdown (above). If the Based on is Actual, then there will be a “$” to the left of each level and the amount entered in the field will update the Actual Price field with that amount. If it is set for Discount% then only the topmost field will have a “$” to the left, signifying that is the amount to be discounted. Each of the levels below will have a “%” to the left, signifying they are to be the percent of discount taken from the topmost field.
The Actual Price is the result of the Price Basis and the Based On method. You can only edit this field directly if the Allow Price Field Updates and Reverse Calculation option is checked (Administration>System>Set System Defaults>IP>Item Master).
1.6.11.2.1. Qty Disc Applies (base)
1.6.11.2.2. Price Basis (base)
1.6.11.2.3. Actual Price (base) 
1.6.11.2.4. Qty Disc Applies (price A)
1.6.11.2.5. Price Basis (price A)
1.6.11.2.6. Actual Price (price A)
1.6.11.2.7. Qty Disc Applies (price B)
1.6.11.2.8. Price Basis (price B)
1.6.11.2.9. Actual Price (price B)
1.6.11.2.10. Qty Disc Applies (price C)
1.6.11.2.11. Price Basis (price C)
1.6.11.2.12. Actual Price (price C)
1.6.11.2.13. Qty Disc Applies (price D)
1.6.11.2.14. Price Basis (price D)
1.6.11.2.15. Actual Price (price D)
1.6.11.2.16. Qty Disc Applies (price E)
1.6.11.2.17. Price Basis (price E)
1.6.11.2.18. Actual Price (price E)
1.6.11.3. Qty Discounts
This tab controls the quantity discounts that might be setup for either the primary pricing levels of the item, and/or for price lists that contain the item. It alternately controls unit of measure pricing. Whether the quantity discounts apply to a given level depends whether the Qty Disc Applies option is checked. Note that the Qty Disc Applies option next to the levels applies to any price lists assigned that item  as well. Unit of measure pricing applies regardless of the option setting.  
1.6.11.3.1.  (method)
This dropdown can be set to either % (percentage) or Actual Price. (The Countertop setting is not used.) It determines whether the amount entered in the Discount or Price column in the grid below will be used to calculate a discounted price from the usual price level or used as an actual dollar and cents price in lieu of the price level price. It is the same for all of the rows in a particular discount setup but could be different for a setup for another price list. 
1.6.11.3.2. Price List
This dropdown defaults to Normal Price, i.e., the prices for items that are used when no price list is in effect. To set different quantity discounts for an item on a price list select a valid price list from the dropdown.  A price list will not utilize quantity discounts if it has no specific setup for it. Setting up a quantity discount for an item that is not already on a price list will automatically add it to that list.
1.6.11.3.3.  (grid)
1.6.11.3.3.1. Unit of Meas.
In a quantity discount setup this field is for reference only. Many companies choose to set all rows to EACH to avoid user confusion. A box may contain 10 each and there may be a discount for buying a box but the quantity ordered is still entered as 10. Entering BOX here might suggest to users that they should enter the quantity of boxes ordered, which the system would see as just a quantity of one unit, not 10.
If unit of measure pricing is being setup then this column should reflect the actual unit of measure, such as EACH, BOX, CARTON, PACK, etc. so that user knows what quantity to enter. If a box or 10 each is being purchased then the user would enter 1 BOX. 
1.6.11.3.3.2. Minimum
If this is a quantity discount setup then the amount entered here is the minimum quantity that must be ordered to qualify for the discount. Usually the top row is setup for a quantity of just 1, and other quantities are entered below it. If there is a row with a minimum of 10 and another with a quantity of 100, then order quantities of from 10 to 99 will qualify for the discount on that row and orders for 100 or more will qualify for the discount on the minimum 100 row.
If this is a unit of measure setup then the minimum should be for the exact quantity of each in that UOM. The units sold will depend on the UOM selected.  For example, if a user selects a UOM of EACH and an order quantity of 10 is entered, the order will be priced at the EACH price. The user must select BOX and enter a quantity of 1 to get the BOX price.
1.6.11.3.3.3. Discount or Price
Usually a discount percent is entered.  It’s important to remember that if an Actual Price (see above) is entered it will be used in place of price levels. If prices are increased at a later date, an Actual Price would not automatically be increased.
1.6.11.3.4. Manual Discount Selection
This option gives the user the prompt to select a row from the discount setup in order entry. This option  must be selected if unit of measure pricing (below) is selected or the user will not be able to designate the UOM. It is not usually selected for quantity discounts because the user will be able to select any discount regardless of the quantity being ordered.
1.6.11.3.5. Unit of Measure based Pricing
By checking this option you are changing the quantity discount setup above to unit of measure pricing, which is significantly different. See documentation. Manual Discount Selection must be selected as well, or users will not be able to select a UOM and quantity.
1.6.11.3.6. Default Pkg Size
If the entry in this first matches a unit of measure it will be the UOM highlighted when the user is prompted to select a UOM and quantity. It must match the Unit of Meas (above) exactly. If the preferred default is the row identified as “EA”, then the Default Pkg Size must be “EA”, not “EACH” or “Each” or “ea”.
1.6.11.4. Cost Calculations
1.6.11.4.1. (grid)
1.6.11.4.1.1. Description
1.6.11.4.1.2. Value
1.6.11.4.1.3. Last Change
1.6.11.5. Sales
1.6.11.5.1. Allow Description Edit
Check this option if you want to allow users to change the description of this item in order entry or purchasing. The changed description does not change the description on file in the item record, only in the specific order.
1.6.11.5.2. Extra Freight Required
If this option is checked the user in order entry will receive a message when they enter this order that the item entails additional freight charges for shipping.
1.6.11.5.3. AR/GL Posting Disabled
Checking this option will exclude the item from posting to the accounts receivable or general ledger when it is sold, in effect disregarding the accounting system. This option is very rarely used. Contact BCR support if you believe this may apply to a need.
1.6.11.5.4. Multi-Unit Item
1.6.11.5.5. Qty/Area
1.6.11.5.6. Don’t allow return of this item
If this option is checked this item cannot be entered on a credit memo or as a negative quantity allocated on a sales order.
1.6.11.5.7. Get Cost Entry
This option must be checked if authorized users are to be allowed to change the cost. Otherwise no changes to the cost will be allowed in order entry.
1.6.11.5.8. Override Entered Cost
1.6.11.5.9. Dimensional Item
1.6.11.5.10. Catch Weight
1.6.11.5.11. Print On
Each checkbox sets the item to print on that document. This assumes that the form is designed to consider this setting. 
1.6.11.5.11.1. Quotes
1.6.11.5.11.2. Orders
1.6.11.5.11.3. Invoices
1.6.11.5.12. Min Qty
This is the minimum SALES quantity, not the minimum inventory setting. An entry of “4” here would mean that the order quantity on a sale must be at least 4.
1.6.11.5.13. Max Qty
This is the maximum SALES quantity, not the maximum inventory setting. An entry of “20” here would mean that the order quantity on a sale must be no more than 20.
1.6.11.5.14. Default Qty
This is the default quantity that will fill the order quantity in sales orders. It is used as a convenience, especially for items that are typically sold in a particular quantity.  If set it can be overridden in the order so long as another setting does not prevent it.
1.6.11.5.15. Selling Multiples
A quantity set here will restrict all order quantities to a multiple of this quantity. If the setting is 4 then the order quantity will initially default to 4. Depending on the setting of Auto Round Multiples (below) only order quantities of 4, 8, 12, etc. might be allowed.
1.6.11.5.16. Auto Round Multiples
1.6.11.5.17. Minimum User Level
1.6.11.6. Special Pricing
1.6.11.6.1. Item Sale Price
The item sale price, when an order is placed within the Start Date and End Date, will override the regular price of the item IF the Sale Price is lower than the regular price. The only exception is when the regular price comes from a price list. The Sale Price is only used if it is lower than the price list item price AND the “Use Item Sale Price if lower than Price List” option is checked for that item on that price list.
1.6.11.6.1.1. Start Date
1.6.11.6.1.2. End Date
1.6.11.6.1.3. Sale Price
1.6.11.7. Customer Based Pricing
1.6.11.7.1. Pricing Category
A single valid Price Category can be assigned to an item using this dropdown. Items assigned this category can then be discounted for individual customers, or groups of customers using the matrix. A new price category can be created using Administration>Edit>Edit Pricing Categories.
1.6.11.7.2. Remove
Click this button to completely remove any price category (above) rather than replace it with another.
1.6.11.8. Assortment Discount Code
1.6.11.8.1. (code)
A single valid Assortment Discount Code can be assigned to an item using this dropdown. Items assigned this code can then be discounted based on the total quantity of all items assigned that code on a single sales order. The discount is not customer specific but does require the user to activate the discount in order entry. A new assortment discount code can be created using Administration>Edit>Edit Assortment Discount.
1.6.11.8.2. Remove
Click this button to completely remove any assortment discount code (above) rather than replace it with another.
1.6.12. Ordering
1.6.12.1. Item/Description
1.6.12.2. Cost
1.6.12.2.1. Standard Cost
The standard cost is typically the replacement cost of the item, i.e., the next cost. How it is used in your system configuration will depend greatly on a number of other system settings. If cost markup pricing is used this is the cost that is used. The standard cost may be displayed on the order entry detail tab in addition to the cost used for inventory valuation. This field is mirrored on the Edit tab.
1.6.12.2.2. Most Recent Cost
The most recent cost is the cost of the last purchase receipt posted for this item.
1.6.12.2.3. Landed Cost
The landed cost is calculated as a weighted average. When freight is apportioned to the item cost on a receipt, as opposed to expensed, it is a landed cost. The current quantity on hand and the current landed cost are multiplied for a total landed value. The receipt quantity and the landed cost on the receipt are multiplied as well. These two figures are added together and divided by the total now on hand for a new landed cost.
1.6.12.2.4. Rental Cost
If this is a rental item this is the cost that will be used when the item is rented. It frequently is left at zero. If the item is also sold then the regular costing is used. Items that are rented are typically not also sold as new. So if you wish to associate a cost to a rental item you will probably associate a different “cost of goods” GL account with the item that is actually an operating expense associated with the act of renting. 
1.6.12.2.5. Average Cost
The average cost is calculated as a weighted average. Unlike landed cost, the freight is not considered. The current quantity on hand and the current average cost are multiplied for a total average value. The receipt quantity and the average cost on the receipt are multiplied as well. These two figures are added together and divided by the total now on hand for a new average cost.
1.6.12.2.6.  (grid)
1.6.12.2.7. Ordering
1.6.12.2.7.1. U/M Sales
The entry here is purely for descriptive purposes. It has no function in sales order entry. It might be used in forms design and can show on the order entry Detail tab.
1.6.12.2.7.2. U/M Orders
The entry here is purely for descriptive purposes. It has no function in purchase order entry. It might be used in forms design and shows on the purchase order entry Items tab.
1.6.12.2.7.3. Factor
Any entry in this field other than 1 will dramatically affect the entry of purchase orders. For example, you might sell this item by the each but the vendor requires that it be purchased by the box of 10. If you enter 10 as a factor an entry of 1 on a purchase order is taken to mean 10 each. Throughout the system the item would show as having 10 on order. But the PO would show one. In this case the U/M Orders (above) would reflect the unit of measure corresponding to the factor (e.g., BOX).
1.6.12.2.7.4. Box Quantity
This field is used to insure that order quantities are rounded to quantities required by vendors. It DOES NOT convert the quantities based on a unit of measure, as the Factor does (above.) For example, a vendor will only ship in boxes of 10. So an order of 11 or 9 would not be acceptable to the vendor. The Box Quantity will cause suggested PO quantities to always round to that quantity. It does not affect manual PO creation but is displayed on the PO Items tab for reference.  The Box Quantity can be combined with the Factor but usually setting the Factor is sufficient if the vendor requires the order to be in the unit of measure quantity.
1.6.12.2.7.5. PO Qty Decimals
The entry here limits the number of decimals that will be expressed in an auto-generated PO quantity suggested for this item.
1.6.12.2.7.6. Weight
This is the weight that is used to calculate the total weight of a sale or purchase. The weight should be in a common measure company wide. If one item’s weight is expressed in pounds then all items should be in pounds or pound and decimals.
1.6.12.2.7.7. Lead Time (Days)
1.6.12.2.7.8. Shelf Life (Days)
1.6.12.2.7.9. Manual Allocation?
Depending on switch settings, the system will automatically fill the allocated quantity with the quantity ordered or whatever quantity is available up to that quantity. If this option is checked the system will leave the quantity allocated at 0 for this item and the user must enter the quantity to allocate manually.
1.6.12.2.7.10. Rental?
This must be checked if the item is to be used in the rental scheduler. See documentation.
1.6.12.2.7.11. Default PO Cost to Zero
As the label suggests, setting this option will cause the cost of this item to be zero (0) when the item is entered on the PO. This is useful when the cost of the item tends to fluctuate with each purchase and the user should be forced to research the current cost with each new purchase.
1.6.12.2.7.12. Stocked Item?
If the item is a tangible item and you want it identified as a stocked item in purchasing reports then this box must be checked. If this is not a tangible stocked item and this box is not checked then the non-stock options (below) will appear. 
1.6.12.2.7.13. Non-Stocked Type (if not Stocked Item)
If the Stocked Item box is not checked then these options are displayed. A Nontangible/Service item would be something that is not a physical good stored in your warehouse, such as an hourly labor charge. An Absolute Misc. is similar but the user must enter a price even if the item has a price set, whereas a Nontangible could have a preset price. A Tangible item is simply an item that is not intended to be stocked. Some purchasing reports will exclude Non-stock Tangible items.
1.6.12.2.7.13.1. Nontangible/Service
1.6.12.2.7.13.2. Tangible
1.6.12.2.7.13.3. Absolute Misc.
1.6.12.2.7.14. Drop Shipments
Drop (direct) ship items can be designated in sales order entry (The “DS” column on the Detail tab) as being shipped by the vendor to the customer, instead of coming from inventory. The item can be set to allow (default), not allow, or only drop ship, meaning no shipment from stock is permitted.
1.6.12.2.7.14.1. Allowed
1.6.12.2.7.14.2. Not Allowed
1.6.12.2.7.14.3. Only Drop Ship
1.6.12.2.7.15. Special Order Only
If this option is checked sales orders for this item will automatically prompt the user to create a PO ordering the item.
1.6.12.2.7.16. Reorder By
Determines whether a min/max or EOQ (order point/line point) scheme should be used for proposed purchase quantities. EOQ has only limited functionality at this time.
1.6.12.2.7.16.1. Min/Max
1.6.12.2.7.16.2. EOQ
1.6.12.2.7.17. Min/Max Settings (if Min/Max)
The minimum and maximum quantities determine the trigger and order up to quantities. The Max (Up To) is Order Quantity in System Defaults (IP>EOQ) will use Max a the order quantity regardless of the current status of stock. IMPORTANT: The min and max settings are location specific to the Reordering Location indicated in the dropdown below. Different locations and  “All Locations” can each have different settings. The ‘Sum Min/Max from Warehouses when “All Locations” is selected’ (System Defaults>IP>EOQ) switch will override this.   
1.6.12.2.7.17.1. Min
1.6.12.2.7.17.2. Max
1.6.12.2.7.18. AuxItem # History (if EOQ)
1.6.12.2.7.19. Reordering Locations
The min/max settings (above) apply to the reordering location indicated in this dropdown.
1.6.12.2.7.20. Replenish From
1.6.12.2.7.21. Seasonal (by location)
1.6.12.2.7.22. Include Dropships (by location)
1.6.12.2.8. Commission Factor/Costs
1.6.12.2.8.1. Commission Factor
1.6.12.2.8.2. Sales
1.6.12.2.8.3. Rentals
1.6.12.2.9. Import Cost Multiplier
1.6.12.2.9.1. Multiplier
1.6.12.2.10. Rebate Type Code
1.6.13. Status
The top grid on this tab lists the transactions that have involved this item. Note the filters on the right side. The Running Total button will add a column of the on hand as of each transaction but you must first chose a single warehouse location from the dropdown.  Double click on a specific transaction line to see the details of that transaction.
At the bottom of the tab are a number of sub-tabs, similar to those found in order entry on the details tab.  Double click on transactions to see their detail. The Ext Desc tab allows you to maintain the four extended descriptions for the item. Other sub-tabs are for reference only.  
1.6.13.1. Transactions (grid)
1.6.13.2. (locations)
1.6.13.3. Display Options
1.6.13.3.1. All
1.6.13.3.2. Sales
1.6.13.3.3. Receipts
1.6.13.3.4. Credits
1.6.13.3.5. Adjustments
1.6.13.3.6. Transfers
1.6.13.3.7. Builds (BOM)
1.6.13.3.8. Deliveries
1.6.13.4. Current/History
1.6.13.4.1. Current
1.6.13.4.2. History
1.6.13.5. On Hand
1.6.13.6. On Sales Order
1.6.13.7. Allocated
1.6.13.8. Available
1.6.13.9. On PO
1.6.13.10. Ext Desc
1.6.13.10.1. Cust (text box)
1.6.13.10.2. Inside Sales (text box)
1.6.13.10.3. Purchase Orders (text box)
1.6.13.10.4. Receipts (text box)
1.6.13.11. Qty (grid)
1.6.13.12. Alt (grid)
1.6.13.13. Eqv (grid)
1.6.13.14. POs (grid)
1.6.13.14.1. Filter
1.6.13.14.1.1. Show All
1.6.13.14.1.2. Received
1.6.13.14.1.3. Posted
1.6.13.14.1.4. Un-Posted
1.6.13.14.1.5. Closed
1.6.13.15. Quotes (grid)
1.6.13.16. Sls Ord (grid)
1.6.13.16.1. Filter
1.6.13.16.1.1. Show All
1.6.13.16.1.2. Unshipped
1.6.13.16.1.3. Backorders
1.6.13.16.1.4. Lost Sales
1.6.13.17. Invcs (grid)
1.6.13.17.1. Filter
1.6.13.17.1.1. Show All
1.6.13.17.1.2. Unshipped
1.6.13.17.2. Current/History
1.6.13.17.2.1. Current
1.6.13.17.2.2. History
1.6.13.18. Pic (grid)
1.6.13.19. Receipts (grid)
1.6.14. BOM
This tab allows you to set up and maintain a bill of materials (BOM) for this item. BOM items can be purchased and stocked as items or they can be assembled in house. There is also a tab for Kit Components. Kits are not maintained as items that are themselves purchased and stocked. They are maintained in the Edit Kits program (Administration>Edit). See documentation.
1.6.14.1. Components
1.6.14.1.1. Current Item
1.6.14.1.1.1. Allow changes to BOM during Assembly
1.6.14.1.1.2. Auto-Build on demand in Order Entry
1.6.14.1.2. (grid)
1.6.14.1.2.1. Item
1.6.14.1.2.2. Description
1.6.14.1.2.3. Qty
1.6.14.1.2.4. Std. Cost
1.6.14.1.2.5. Avg. Cost
1.6.14.1.3. Update Item Standard Cost
1.6.14.1.4. Calculate Total Cost
1.6.14.1.5. Std. Cost
1.6.14.1.6. Avg. Cost
1.6.14.2. Outline (tree)
1.6.14.3. Where Used (grid)
1.6.14.4. Kit Components (grid)
1.6.15. Relationships
Any number of items can be listed as substitutes or related to this item. When this item is entered in sales order entry, tabs at the bottom of the Detail tab will display these items and you can double click on one to immediately add it to the order. You can create an unlimited number of aliases for this item and they can be used to retrieve the item instead of the item#. Be sure that the alias is not used for any other item. 
1.6.15.1. Substitutes
1.6.15.2. Related Items
1.6.15.3. Aliases
1.6.15.3.1. + (plus button)
1.6.15.3.2. – (minus button)
1.6.15.4. Related Reverse
1.6.15.4.1. + (plus button)
1.6.15.4.2. – (minus button)
1.6.16. History (grid)
This tab displays sales performance information by month for every year of history available. No user maintenance is performed on this screen.
1.6.17. Pictures 
Use this tab to associate files of a variety of types (not just pictures) to this item, including images, PDFs, URLs, text files, or any file type that your PC can open. Any number of file locations can be entered. These files will be listed in order entry and can be opened from there by double clicking.
1.6.17.1.  (grid)
1.6.17.2. View / Open
1.6.17.3. Print
1.6.17.4. (no label)
1.6.17.4.1. Sequence
1.6.17.4.2. Type
1.6.17.4.3. Description
1.6.17.4.4. Path
1.6.17.4.5. Use in E-Commerce
1.6.17.4.6. Find Picture
1.6.17.4.7. Find File
1.6.17.4.8. Select Printer
1.6.18. Processes
1.6.18.1. Item Processes
1.6.19. Vendors
If the Multiple Vendors Per Item option (Administration>System Defaults>IP>Item Master) is checked then you can associate an unlimited number of vendors with this idea. The first vendor entered is considered the primary vendor but once other vendors are added, another vendor can be selected from the Vendor dropdown on the Edit tab. A variety of vendor specific details can be entered in the grid.
The grid at the bottom of this tab is specific to the vendor highlighted above and allows you to setup quantity discounts that vendor offers on this product that will affect the PO cost. 
1.6.19.1.  (grid)
1.6.19.1.1. Vendor
1.6.19.1.2. Name
1.6.19.1.3. Vendor Item Number
1.6.19.1.4. M R Cost
1.6.19.1.5. M R Date
1.6.19.1.6. LeadTime
1.6.19.1.7. Factor
1.6.19.1.8. Box Qty
1.6.19.1.9. Standard Cost
1.6.19.1.10. Rebate %
1.6.19.1.11. Rebate $
1.6.19.1.12. Drop Ship MinQty
1.6.19.1.13. Vendor Item Description
1.6.19.1.14. (UD1)
1.6.19.1.15. (UD2)
1.6.19.1.16. (UD3)
1.6.19.1.17. (UD4)
1.6.19.2. Vendor Note
1.6.19.3. Vendor Purchase Order Quantity Discounts
1.6.19.3.1. Warehouse
1.6.19.3.2. Discount Method
1.6.19.3.2.1. %
1.6.19.3.2.2. Actual Cost
1.6.19.3.3. Multiple Purchasing Units
1.6.19.3.4. (grid)
1.6.19.3.4.1. U/M
1.6.19.3.4.2. Minimum
1.6.19.3.4.3. Discount or Cost
1.6.20. Customers
You can associate any number of specific customers here with this item, usually because the customer requires you to refer to the item by a different item number or description. This tab is not tied to the Customer field on the Edit tab.
The grid in the lower part of the tab allows you to reserve stock of this item for specific customers. Reserved stock does not reduce the on hand or available but it will only allow sales to that customer to use that quantity. For example, an item has 10 available but 5 are reserved for a customer. If another customer orders 6 of that item, only 5 will be allocated because the remaining 5 are reserved. If the customer for whom the stock is reserved orders 6 then all 6 are allocated. Reserved stock is not reduced by transactions.
1.6.20.1.  (grid)
1.6.20.1.1. Customer
1.6.20.1.2. Name
1.6.20.1.3. Customer Item Number
1.6.20.1.4. Item Description
1.6.20.1.5. Picking Location
1.6.20.1.6. Rebate %
1.6.20.1.7. Rebate $
1.6.20.1.8. Box Qty
1.6.20.2. Reserved Quantity
1.6.20.2.1. Synchronize with grid above
1.6.20.2.2. Expired
1.6.20.2.3. Current
1.6.20.2.4. Future
1.6.20.2.5. (grid)
1.6.20.2.5.1. ID
1.6.20.2.5.2. Loc
1.6.20.2.5.3. Reserved Qty
1.6.20.2.5.4. Start Date
1.6.20.2.5.5. End Date
1.6.21. Graphs
1.6.21.1. Months
1.6.22. Notes
On this tab you can enter notes related to this item in a tree type of forum message board.
1.6.22.1. Notes Forum (tree)
1.6.22.2. Note (text box)
1.6.22.3. Compose
1.6.22.4. Reply
1.6.23. Catalogs
Items can be designated as on one or more catalogs. See documentation
1.6.23.1.  (grid)
1.6.23.1.1. Catalog
1.6.23.1.2. Page #
1.6.23.1.3. Start Date
1.6.23.1.4. End Date
1.6.23.1.5. Type
1.6.23.2. Catalog Desc
1.6.23.3. Web Desc
1.6.23.4. Web HTML
1.6.23.5. Showroom Desc
1.6.24. Additional
Up to fifteen user defined fields and three user defined memo fields can be maintained for items. Fields only appear on this tab when they have labels assigned in System Defaults on the IP>Additional tab. These fields are information only and typically used in customer Report Writer reports or forms.
1.6.24.1.  (UD1)
1.6.24.2. (UD2)
1.6.24.3. (UD3)
1.6.24.4. (UD4)
1.6.24.5. (UD5)
1.6.24.6. (UD6)
1.6.24.7. (UD5)
1.6.24.8. (UD6)
1.6.24.9. (UD7)
1.6.24.10. (UD8)
1.6.24.11. (UD9)
1.6.24.12. (UD10)
1.6.24.13. (UD11)
1.6.24.14. (UD12)
1.6.24.15. (UD13)
1.6.24.16. (UD14)
1.6.24.17. (UD15)
1.6.24.18. (UD Memo1)
1.6.24.19. UD Memo2)
1.6.24.20. (UD Memo3)
1.7. Edit Jobs
1.8. Edit Job Phases
1.9. Edit Job Cost Types
1.10. Edit Customer Terms
1.11. Edit Vendor Terms
1.12. Edit PO Special Orders
1.13. Exit
2. Edit
2.1. Edit Price List
2.2. Edit Pricing Categories
2.3. Assign Customer Price Lists
2.4. Edit Assortment Discounts
2.5. Edit Price Schedule Codes
2.6. Edit Item Classes
2.7. Edit Kits
2.8. Edit Sales Tax Table
2.9. Edit Checking Accounts
2.10. Edit Shipping Methods
2.11. Edit Tiered Freight
2.12. Edit Credit Card Types
2.13. Edit Payment Methods
2.14. Edit Processes
2.15. Edit Currencies
2.16. Edit Routes
2.17. Edit GL Entities
2.18. Edit GL Cost Centers
2.19. Edit GL Sub Accounts
2.20. Edit Order Sources
2.21. Edit Order Types
2.22. Edit Makes/Models 
2.23. Edit Zip Codes
2.24. Pricing Matrix
2.25. Edit Customer Gifts
2.26. Edit Drivers/Delivery Schedules
2.27. Edit Catalog
3. System
3.1. Set System Defaults
3.1.1. OK
3.1.2. Cancel
3.1.3. Pick List
3.1.4. General
3.1.4.1. Company Information
3.1.4.1.1. Company
WARNING! Any change to this field will invalidate your Titan Access Key and limit your access to a single user. If you need to change your company name please contact BCR support. The Company field is used primarily on reports and forms. 
3.1.4.1.2. Address
Your company physical or mailing address. This is primarily used in forms and reports.
3.1.4.1.3. City, State, Zip
WARNING! Any change to the City or State field will invalidate your Titan Access Key and limit your access to a single user. If you need to change your company city please contact BCR support. The City field is used primarily on reports and forms. 
3.1.4.1.4. Phone
3.1.4.1.5. Country
3.1.4.1.6. Fax
3.1.4.1.7. Federal ID
WARNING! Any change to this field will invalidate your Titan Access Key and limit your access to a single user. If you need to change your company federal employer ID please contact BCR support. The Federal ID field is used primarily on reports and forms.  
3.1.4.1.8. State ID
3.1.4.1.9. Company Motto
3.1.4.2. Date Format
3.1.4.2.1. Short Date Format
3.1.4.3. Sub Database
3.1.4.3.1. Allow Sub Database
3.1.4.4. License
3.1.4.4.1. Maximum Simultaneous Users
DO NOT ATTEMPT TO CHANGE THIS FIELD. Your Access Key determines your maximum number of users.  If you need additional users please contact BCR support.
3.1.4.4.2. Expiration Date
DO NOT ATTEMPT TO CHANGE THIS FIELD. Your Access Key determines your Expiration Date. After the expiration date you will be limited to a single user.  If you need your expiration date extended please contact BCR support. 
3.1.4.4.3. Access Key
DO NOT ATTEMPT TO CHANGE THIS FIELD. Your Access Key determines your maximum number of users, your expiration date, and the availability of Titan optional products. It can only be set by BCR support. An incorrect access key will disable your software license.
3.1.4.4.4. Print
3.1.4.5. Database Tracking
3.1.4.5.1. Allow Database Change Tracking
3.1.4.6. Phone Number Edit Mask
3.1.4.6.1. Standard
3.1.4.7. Fax Server
3.1.4.7.1. Server
3.1.4.7.2. COM Port
3.1.4.7.3. File Path
3.1.4.7.4. (drive selector)
3.1.4.7.5. (folder tree)
3.1.4.7.6. Add 1 to 10 Digit Fax Numbers before dialing
3.1.4.7.7. Attachment Document Type
3.1.4.7.8. Fax Prefix
3.1.4.8. EDI
3.1.4.8.1. Qualifier
3.1.4.8.2. ID
3.1.4.9. International
3.1.4.9.1. Multi-Currency
Turns on a number of currency fields for customers that buy and/or sell goods in more than one country and must convert amounts from one currency to another. 
3.1.4.10. Commissions
3.1.4.10.1. Commissions Reporting By
Selects the default setting for commissions reports, but can be changed in the report setup.
3.1.4.10.1.1. Salesman Totals
3.1.4.10.1.2. Invoice
3.1.4.10.1.3. Invoice Line
3.1.4.10.2. Select Paid Invoices By
Selects the default setting for commissions reports, but can be changed in the report setup.
3.1.4.10.2.1. Paid Date
3.1.4.10.2.2. Invoice Date
3.1.4.10.3. Negative Commission Possible
If checked this means credit memos will be included in the commission calculation, which could result in a negative commission due a salesperson.
3.1.4.10.4. Recalculate Prices based on Class Multiplier
3.1.4.11. Server/PC Time
3.1.4.11.1. Notify User if More Than _ Minutes Difference
3.1.4.12. Open Drawer
3.1.5. GL
3.1.5.1. Posting Accounts
3.1.5.1.1. Cash
The default GL account for all transactions involving money expended or redeived, such as AR or check printing. The default can be overridden in bank setup or at the transaction level. Must be a valid account number. 
3.1.5.1.2. Retained Earnings
Enter the capital account that Titan should post net profits to when the fiscal year is closed.  
3.1.5.2. Editing
3.1.5.2.1. Edit GL Beginning Balances
Allows an autorized user to change individual account beginning balances in Edit Chart of Accounts. Usually beginning GL balances are established when your company is first installed on Titan and it should not be necessary to edit them from that point forward. You may wish to leave this option unchecked to avoid any undesired editing. In the event you do need to edit them you can check the option, make your correction, and then uncheck.
3.1.5.3. Reports
3.1.5.3.1. Suppress Zero Accounts
3.1.5.3.2. Roll Up Checks
3.1.5.3.3. Use 13 Accounting Periods
Some accountants like to use a 13th period for special and year ending adjustments. Check this box to create the 13th period. 
3.1.5.4. GL Account Default Lookup By
Select Account (ID), Description, or Type to determine which sort the lookup dialog defaults to, though it can be changed when the dialog is displayed. 
3.1.5.5. Do Not Build Acct # from Cost Centers
3.1.5.6. Current Periods
3.1.5.6.1. GL
The current GL module period can be changed here or from within the GL module itself. It is typically updated at the beginning of each fiscal month.
3.1.5.6.2. AP
The current AP module period can be changed here or from within the AP module itself. It is typically updated at the beginning of each fiscal month.
3.1.5.6.3. AR
The current AR module period can be changed here or from within the AR module itself. It is typically updated at the beginning of each fiscal month. NOTE: The AR period also sets the period for the OE (order entry) module.
3.1.5.6.4. IP
The current IP module period can be changed here or from within the IP module itself. It is typically updated at the beginning of each fiscal month.
3.1.5.7. Auto Posting
Determines whether certain transactions are automatically posted to the general ledger. Usually all auto posting checkboxes are checked. Contact BCR support if you have questions about the auto posting of transactions. 
3.1.5.7.1. Administration
3.1.5.7.1.1. Residual Costs
3.1.5.7.2. Accounts Payable
3.1.5.7.2.1. Checks
3.1.5.7.2.2. Check Voiding
3.1.5.7.2.3. Credit / Debit Notes
3.1.5.7.2.4. Instant Checks
3.1.5.7.2.5. Invoices
3.1.5.7.2.6. Manual Checks
3.1.5.7.3. Accounts Receivable
3.1.5.7.3.1. Credit / Debit Notes
3.1.5.7.3.2. Invoices
3.1.5.7.3.3. Payments
3.1.5.7.4. Fixed Assets
3.1.5.7.4.1. Depreciation
3.1.5.7.5. Inventory Purchasing
3.1.5.7.5.1. Adjustments
3.1.5.7.5.2. Assemblies
3.1.5.7.5.3. Receipts
3.1.5.7.5.4. Receipt Adjustments
3.1.5.7.5.5. Transfers
3.1.5.7.5.6. Vendor Returns
3.1.5.7.6. Manufacturing
3.1.5.7.6.1. Assemblies
3.1.5.7.7. Order Entry
3.1.5.7.7.1. End of Day
3.1.5.7.7.2. Inventory and COGS
3.1.5.7.8. Payroll
3.1.5.7.8.1. Imputed income
3.1.5.7.8.2. Data Changes
3.1.5.7.8.3. Checks
3.1.5.7.8.4. Check Voiding
3.1.6. AP
3.1.6.1. Bank
3.1.6.1.1. Default Bank
Bank accounts are setup in Edit Checking Accounts. Each one is assigned a number. The bank number entered here will be the default bank for transactions such as checks printed or cash receipts to be deposited. The bank can be overridden at the transaction level.
3.1.6.2. Tax Authority
This is the tax authority that is used in AP Invoice Batches if the authority requires you to pay a sales tax on a payable expense that the vendor has not charged you. Typically this is set to the tax authority you reside in. This feature is not often used. Contact BCR support for further information.
3.1.6.3. Vendor ID
This setting is typically made when the software is installed. Contact BCR support if you feel it needs to be changed.
3.1.6.3.1. Justification
3.1.6.4. Distribution Method
This dropdown determines how freight is apportioned to individual items on a receipt. This is only done if the Expense Freight/Other on Invoice Entry option is NOT checked here or in invoice entry.  It is usually set to "cost", i.e., the percent of the total cost of a receipt represented by the total cost of the item is taken as the freight to be added to that item average cost calculation. "Quantity" or "Weight" might be used if they are consistently the most significant driving factors in the freight expense. If you do not apply freight to receipts then this setting will not matter.   
3.1.6.4.1. Expense Freight/Other on Invoice Entry
If this option is checked then freight added on a receipt will be treated as a separate expense and not incorporated into the cost of the inventory. This option can be overridden on the individual invoice entry in AP.  
3.1.6.4.2. Redistribute Freight on Partial Invoices
3.1.6.4.3. Enable Filter by Warehouse Location
3.1.6.5. Invoice Description Default
[bookmark: bm]Select the default to fill the Description field for each invoice line entered in AP>Enter/Edit Invoice Batches. The user can override the default on entry if necessary.  
3.1.6.6. Check Options
3.1.6.6.1. Show Our Company Name
3.1.6.6.2. Show Our Company’s Customer Number
3.1.6.6.3. Print Check Journal in Check Number Order
3.1.6.7. Posting Accounts
These are the default GL accounts for postings related to accounts payable. Consult BCR support and your accountant for advice on correct assignment.  
3.1.6.7.1. Accounts Payable
3.1.6.7.2. Sales Tax Payable
3.1.6.7.3. AP Discounts
3.1.6.7.4. Freight Expense
3.1.6.7.5. COGS Adjustments
3.1.6.7.6. Duty Charges
3.1.6.8. Vendor Default Lookup
This setting determines the initial sort/lookup field for the vendor pick lists.  
3.1.6.9. Allow Multi-Part Invoices
If a vendor gives you terms to allow staged payments on a single invoice you can split payments in AP invoice batches. This option must be checked to display the necessary fields in Invoice Batch entry.  
3.1.6.10. User Defined Fields
Enter the field labels for user defined fields to be displayed  in the Edit Vendor. Fields will not be displayed if no label is entered here.  
3.1.6.10.1. User Defined Name 1
3.1.6.10.2. User Defined Name 2
3.1.6.10.3. User Defined Date Name
3.1.6.11. Vendor Rebates
This option enables the Rebate Master, one of three different vendor rebate solutions in Titan. Checking it will add a Rebates menu to the Administration module. See rebate documentation. 
3.1.6.11.1. Customer/Item Type Enabled
3.1.6.12. GL Batch Description
3.1.6.12.1. GL Account Name
3.1.6.12.2. AP Invoice Entered DESC
3.1.7. AR
3.1.7.1. Statements
These options have been superseded by enhancements to the statement print program and are no longer supported. 
3.1.7.1.1. Minimum Balance For Statements
3.1.7.1.2. E-Mail or Fax to Customers
3.1.7.1.3. New Customer Default – Print New Invoices w/Statements
3.1.7.1.4. Statement Type
3.1.7.2. Late Charges
3.1.7.2.1. Monthly Late Charge Percentage
3.1.7.2.2. Minimum Late Charge Level
3.1.7.2.3. Late Charge Minimum
3.1.7.2.4. LC Description
3.1.7.2.5. Late Charge Assessed Based On
3.1.7.2.5.1. Document Date
3.1.7.2.5.2. Due Date
3.1.7.3. Posting Accounts
These are the default GL accounts for postings related to accounts receivable. Consult BCR support and your accountant for advice on correct assignment.  
3.1.7.3.1. Accounts Receivable
3.1.7.3.2. A/R Late Charges
3.1.7.3.3. A/R Discounts
3.1.7.3.4. Rebate Clearing
3.1.7.3.5. Misc. Payment
3.1.7.4. Allow Customer Gifts
Enables the customer gift function. See Customer Gifts documentation.
3.1.7.5. AR Payment Under-Apply Warning
Will warn a user whenever the amount applied to a customer's account is less than the amount of the amount received in AR Payments (Enter/Edit Payment Batches.) Remaining amounts are posted to the customer's account as Unapplied. See AR Payment Entry documentation.
3.1.7.6. Update OE Region By
3.1.7.6.1. Customer
3.1.7.6.2. Office
3.1.7.6.3. Salesperson
3.1.7.6.4. Independent
3.1.7.7. Cust Default Lookup By
3.1.7.8. Select By Office Location
3.1.7.9. Payment Batches
3.1.7.9.1. Auto-Select Invoices
3.1.7.9.2. Allow Order Number Entry
3.1.7.9.3. Add Total Payment Record
3.1.7.9.4. Default Bank
3.1.7.9.5. Consolidate GL entries
3.1.7.10. Other Customer Defaults
3.1.7.10.1. ID Justification
This setting is normally made when Titan is installed. This setting has a dramatic impact on the way customers are sorted by ID and should only be changed on consultation with BCR support.
3.1.7.10.2. Tiered Freight Code
Sets the default tiered freight code for new customers. Tiered freight is used to determine the freight to be charged based on the total price of goods to be shipped. The freight charge can be a fixed amount or a percent of the shipped amount. Different tiers (minimum shipped amount) determine different freight amounts or percent. Different codes can have different tiers and amounts. Codes are established in the Edit Tiered Freight program on the Edit menu in Administration.  
3.1.7.10.3. Allow Pre-Billing
Pre-Billing allows you to bill a customer for orders before they are allocated. When the goods are allocated they are not invoiced again. This function is typically used when customers are expected to pay for goods up front, before they are special ordered. See Pre-Billing documentation.
3.1.7.10.4. Pre-Bill Rentals
This option is only activated if the Rental Tracking (OE>Switches>Detail) is turned on .
3.1.7.10.5. Alternate Taxing Available
3.1.7.10.6. Customer Name is Primary
3.1.7.10.7. Do NOT auto-apply CR to invoices
3.1.7.10.8. Use Cust ID Prefixes & Auto#
3.1.7.11. Monthly Processing
3.1.7.11.1. Discounts
3.1.7.11.1.1. Use Monthly Discounts
3.1.7.11.1.2. New Item Discountable Default
3.1.7.11.1.3. Last Discount Date
3.1.7.11.2. Balance Carry Over
3.1.7.11.2.1. Use Carry Over Accounts
3.1.7.11.2.2. Payment Deduction Months (Number of prior months)
3.1.7.11.2.2.1. January
3.1.7.11.2.2.2. February
3.1.7.11.2.2.3. March
3.1.7.11.2.2.4. April
3.1.7.11.2.2.5. May
3.1.7.11.2.2.6. June
3.1.7.11.2.2.7. July
3.1.7.11.2.2.8. August
3.1.7.11.2.2.9. September
3.1.7.11.2.2.10. October
3.1.7.11.2.2.11. November
3.1.7.11.2.2.12. December
3.1.7.11.3. OE Created Payment Batches
3.1.7.11.3.1. OE End of Day Posting Creates Batches based on
3.1.7.11.3.1.1. One Batch
3.1.7.11.3.1.2. Credit Card/Other
3.1.7.11.3.1.3. Credit Card Type/Other
3.1.7.11.3.1.4. Payment Method
3.1.7.11.3.1.5. Payment Method and Credit Card Type
3.1.7.11.3.2. A/R Payment Cost Center Usage
3.1.7.11.4. User Defined Fields
3.1.7.11.4.1. Primary (CUST)
3.1.7.11.4.1.1. Primary User Defined Field Names
3.1.7.11.4.1.1.1. Field 1
3.1.7.11.4.1.1.2. Field 2
3.1.7.11.4.1.1.3. Field 3
3.1.7.11.4.1.1.4. Date Field
3.1.7.11.4.1.1.5. Copy data to New OE Documents
3.1.7.11.4.1.2. Secondary (CUSTUDEF)
3.1.7.11.4.1.2.1. Field 1
3.1.7.11.4.1.2.2. Field 2
3.1.7.11.4.1.2.3. Field 3
3.1.7.11.4.1.2.4. Field 4
3.1.7.11.4.1.2.5. Field 5
3.1.7.11.4.1.2.6. Field 6
3.1.7.11.4.1.2.7. Field 7
3.1.7.11.4.1.2.8. Field 8
3.1.7.11.4.1.2.9. Field 9
3.1.7.11.4.1.2.10. Field 10
3.1.7.11.4.1.2.11. Field 11
3.1.7.11.4.1.2.12. Field 12
3.1.7.11.4.1.2.13. Field 13
3.1.7.11.4.1.2.14. Field 14
3.1.7.11.4.1.2.15. Field 15
3.1.7.12. Credit Card Saved Information Mask
3.1.8. OE
3.1.8.1. Doc# / Misc
3.1.8.1.1. Document Numbers
See Order and Invoice Numbering Schemes documentation.
3.1.8.1.1.1. Use Office Specific Numbers
If this option is not checked then the different document types will be listed below along with their next document number and the number of extra copies. If it is checked then no types or numbers will be listed here. Each office will have its own numbers. Office locations are maintained by clicking the browser button (...) next to the Multiple Office Locations option on the OE>Switches>General tab. Once office location document numbers are set you should not change them without consulting BCR support.
3.1.8.1.1.2. Use Order # As Invoice #
When this option is not checked then the Invoice number field will be displayed below. The numbering of invoices and orders will be independent of each other. When this option is checked then the Invoice number field is not displayed. When an order is invoiced it will have the same number as the original order. See Order and Invoice Numbering Schemes documentation.
3.1.8.1.1.3. Next Quote
3.1.8.1.1.4. Copies
3.1.8.1.1.5. … (captions browser)
3.1.8.1.1.6. Next Order
3.1.8.1.1.7. Copies
3.1.8.1.1.8. … (captions browser)
3.1.8.1.1.9. Next Invoice
3.1.8.1.1.10. Copies
3.1.8.1.1.11. … (captions browser)
3.1.8.1.1.12. Next Credit
3.1.8.1.1.13. Copies
3.1.8.1.1.14. … (captions browser)
3.1.8.1.1.15. Next Deposit
3.1.8.1.1.16. Copies
3.1.8.1.1.17. … (captions browser)
3.1.8.1.1.18. Next RGA
3.1.8.1.1.19. Copies
3.1.8.1.1.20. … (captions browser)
3.1.8.1.1.21. Pick Ticket Days
3.1.8.1.1.22. Copies
3.1.8.1.1.23. Packing Slip Copies
3.1.8.1.1.24. List/Label
3.1.8.1.1.25. Print copies after emailing / faxing
3.1.8.1.2. Invoice Creation Basis (User Default)
3.1.8.1.2.1. Order Allocation Qty (Classic)
3.1.8.1.2.2. User Selected Pick Ticket Qtys
3.1.8.1.2.3. All Non-Invoiced Pick Ticket Qtys
3.1.8.1.3. Tax Form Warning
This option can be set to Don’t Warn User, Warn On Document Creation, or Prohibit Document Creation. The option is triggered in order entry when the customer Taxable? box is not checked and either the customer has a Tax ID (Edit Customers>Edit>Sales Options tab) entered and the On File box is not checked or a date entered in the Tax Expire Date is passed.
3.1.8.1.4. Minimum Access Levels
3.1.8.1.4.1. Allow Update ALL Customer Information
3.1.8.1.4.2. Order Deletion
3.1.8.1.4.3. Close
3.1.8.1.4.4. Advanced Functions
3.1.8.1.5. Cost Visibility
3.1.8.1.5.1. Item Cost
3.1.8.1.5.2. Total Margin
3.1.8.1.6. Decimal Places
3.1.8.1.6.1. Qty
Enter the number of decimal places to allow for the entry or display of the item quantity. An entry of 0 would only allow a quantity entry and display of whole units. 1 would allow tenths of a unit, etc. Generally you should not set the decimals to any more than needed for any one item in your inventory.  NOTE: Forms and reports may be designed to display other formats.
3.1.8.1.6.2. Price
Enter the number of decimal places to allow for the entry or display of the item price. An entry of 2 would allow a price entry and display of whole cents. 3 would allow tenths of cents, etc. Generally you should not set the decimals to any more than needed for any one item in your inventory. NOTE: Forms and reports may be designed to display other formats.
3.1.8.1.6.3. Cost
Enter the number of decimal places to allow for the entry or display of the item cost. An entry of 2 would allow a cost entry and display of whole cents. 3 would allow tenths of cents, etc. Generally you should not set the decimals to any more than needed for any one item in your inventory. NOTE: Forms and reports may be designed to display other formats.
3.1.8.1.7. Freight Calculation
3.1.8.1.7.1. Auto-Update Actual Charge
3.1.8.1.8. Add ShipTo
3.1.8.1.8.1. Don’t Add
3.1.8.1.8.2. Add With Prompt
3.1.8.1.8.3. Add Without Prompt
3.1.8.1.9. Add BillTo
3.1.8.1.9.1. Don’t Add
3.1.8.1.9.2. Add With Prompt
3.1.8.1.9.3. Add Without Prompt
3.1.8.1.9.4. Auto-Create from ShipTo
3.1.8.1.10. Item Label Qty
3.1.8.1.10.1. OE Item Labels
3.1.8.1.11. UPS Worldship Version
3.1.8.1.12. Shipping Interface From Orders
3.1.8.2. Switches
3.1.8.2.1. General
3.1.8.2.2. Use Report Writer
3.1.8.2.3. Multiple Office Locations
3.1.8.2.4. … (office locations browser)
Click this button to display the Office Locations maintenance screen.
3.1.8.2.5. Automatic Invoicing-On Accnt
3.1.8.2.6. Automatic Invoicing-Cash
3.1.8.2.7. List Documents by Cust/Bill-To
3.1.8.2.8. Require signature in order to release and post an invoice
3.1.8.2.9. Picking Tickets Menu
This option must be checked to add the Print Picking Tickets program to the File menu in Order Entry. The Print Picking Tickets program makes it possible to print picking ticket forms as a batch. Otherwise picking tickets must be printed individually from within the order. Companies that pick orders at specific times to prepare for shippers or scheduled deliveries would be likely to use this program.
3.1.8.2.10. Packing Slips Menu
3.1.8.2.11. Track Lost Sale Details
Checking this option turns on lost sale tracking. Lost sale tracking is triggered if the sales order quantity that was originally entered is later reduced. So if a quantity of 5 was ordered but only 3 shipped and the order quantity was reduced to 3, eliminating the backorder, then the system would ask the user if they wished to track the 2 cancelled as a lost sale. Titan can then report on an item's total lost sales over a given period of time for inventory management purposes. If there is no intention to track this information then the option should not be checked, as it will just impede the order entry process.
3.1.8.2.12. Bypass Finalize Single Invoice
3.1.8.2.13. In Reports, Zero Tax is Taxable
3.1.8.2.14. Quote required date is expiration date
3.1.8.2.15. 
If this option is checked then the date entered in the Req. Date on the Header tab of a quote will be treated as the date that the quote offered will expire. Users will be prevented from copying an expired quote to an order. If it is not checked then the Req. Date has no special function.  
3.1.8.2.16. Notify if Open Credits Exist
3.1.8.2.17. Pick Items Based on Line Date
3.1.8.2.18. Display Qty Change Message
3.1.8.2.19. Never prompt users when inventory is not available (See user settings also)
3.1.8.2.20. Pick Ticket Sales Calc Method
3.1.8.2.21. OE ID Change – Office Location
3.1.8.2.21.1. Don’t Change
3.1.8.2.21.2. Change Regardless of User
3.1.8.2.21.3. Change Only if User Not Locked in
3.1.8.2.21.4. Change to user’s Office Setting if Set
3.1.8.3. Header
3.1.8.3.1. Track Make/Model/Year
3.1.8.3.2. Require “Entered By”
3.1.8.3.3. Shipto Next
3.1.8.3.4. Warn When Pending
3.1.8.3.5. Shipto Phone/Fax Default
3.1.8.3.5.1. One Large Free-form field
3.1.8.3.5.2. Separate Phone and Fax Fields
3.1.8.3.6. Email Pop. Method
Depending on the selection from the dropdown, the email field on new orders will either be blank, the email of the customer, the email of the customer's bill to address used, or the email of the customer's shipto address used. The email can be overridden if necessary in the order.
3.1.8.4. Detail
3.1.8.4.1. Tally (Dimensional) Processing
3.1.8.4.2. Display Deleted Items F12
3.1.8.4.3. Disp. Non-Stock Tangible in Detail w/F12
3.1.8.4.4. Use ComCost on Commission Rpt
3.1.8.4.5. Allocate Using Quantity-To-Pick
3.1.8.4.6. Warn when Backordered
3.1.8.4.7. Re-eval Dimen. On QtyAlloc Change
3.1.8.4.8. F9 Applies to All Doc Types
3.1.8.4.9. Back Orders Allowed
3.1.8.4.10. Copy Ext. Item Desc. To OE line
3.1.8.4.11. Use Description to Associate NS Items on SubTabs
3.1.8.4.12. Dimension on Tab or Enter
3.1.8.4.13. Rental Tracking
Turns on the rental tracking system. When check the Rental Scheduling option is displayed beneath it. See Rental System documentation.  
3.1.8.4.13.1. Rental Scheduling
This option is only displayed because the Rental Tracking option is checked. See Rental System documentation.
3.1.8.4.14. Update Original Quantity when Quantity Ordered is Changed
Normally the original quantity entered as ordered is retained in the order detail (OEDET) for reporting purposes like lost sales. If this option is checked then that quantity is changed whenever the quantitly ordered is changed. The Ask Before Updating option below will give the user the option to change the original quantity or not.    
3.1.8.4.15. Ask Before Updating
This option applies to the Update Original Quantity option above. It gives the user the option to update the original quantity or not.
3.1.8.4.16. Never Prompt User if inventory is not available (Also see User setting)
3.1.8.4.17. OEDETUDEF Fields
3.1.8.4.17.1. U1
3.1.8.4.17.2. U2
3.1.8.4.17.3. U3
3.1.8.4.17.4. U4
3.1.8.5. Shipping/Payment
3.1.8.5.1. Give Change from Tendered
3.1.8.5.2. Default Pay Amt to Total Due for CCs
3.1.8.5.3. Require Payment on Cash Cust
3.1.8.5.4. Warn when Address/Zip code doesn’t match on CC
3.1.8.5.5. Show Deposit amount available to “take” on invoice
3.1.8.5.6. Use Lost Sales Tab
3.1.9. Printing/Posting
3.1.9.1. Printer Selection Criteria (Single Doc)
3.1.9.1.1. By Document Type (Classic)
3.1.9.1.2. By Doc Type & Original Form Name
3.1.9.1.3. By Doc Type & Each Form Name
3.1.9.1.4. By Doc Type, Pay Method & Form Name
3.1.9.2. Lot/Picking Location Printing
3.1.9.2.1. Classic
3.1.9.2.2. Oldest (FIFO)
3.1.9.2.3. Most Recent (LIFO)
3.1.9.3. Posting
3.1.9.3.1. GST
3.1.9.3.2. Rate
3.1.9.3.3. Sales Tax
3.1.9.3.4. Summarize GL
3.1.9.3.5. Freight
3.1.9.3.6. Use Warehouse Cost Center
3.1.9.3.7. Handling Charge
3.1.9.3.8. Handling Charge Description
3.1.9.4. Work Orders
3.1.9.4.1. Print Detail
3.1.9.4.2. Print Cost
3.1.9.5. Use Hold/Release
The Hold/Release Invoices program is an optional method of finalizing (pre-post) invoices. It is usually used in combination with Auto-Invoice but can be used as an optional step to Print/Process Invoices if invoices are created using the batch invoicing routine. Refer to Order and Invoicing Flow Options documentation for additional information.
3.1.9.6. Finalize Released Invoices
3.1.9.7. Do Not Change Printed Status
3.1.9.8. Put Deposits on Hold Also
3.1.9.9. Plain Paper Forms
3.1.9.10. Default Form in Print Range – Customer Default if checked, vs. System Default
3.1.9.10.1. Print Work Order Summary Page
3.1.9.10.2. Auto Close Completed Sales Orders
If this option is checked and the quantity allocated equals the quantity ordered for all items on the order then the order will be automatically closed when the order is invoiced. Once an order is closed quantities cannot be changed and items cannot be added. Any item that has a quantity ordered that is greater than the quantity allocated, i.e., a backorder, will not be automatically closed.
3.1.10. Pricing
3.1.10.1.1. Use Base on Discounted Orders
There are fields on the Header and Payment tabs of the order that can be used to apply additional discounts to all of the prices of the ordered items. If this option is checked then the discount percents are applied to the "Base" price, the topmost of the six price levels in the item record. If it is not checked then the discount is applied to the automatic pricing set for the customer.
3.1.10.1.2. User Price Schedule Codes
3.1.10.1.3. Categories Before Schedule Codes
3.1.10.1.4. PriceList Price Overrides Min Price
If this option is checked then an item price on a price list assigned to a customer will be used even if it is lower than the Minimum Price set on the item in item maintenance. If not checked, then the price cannot be lower than the minimum price. If price lists represent contracts then this option should not be checked.
3.1.10.1.5. Price Discount On OrigAmt if Editable
Prices can be discounted from the price column in order entry by entering a percentage followed by a(for discount), M (for markup on cost), or G (for gross margin), e.g., 20D for a price of .8 times the customer's normal price. The normal price is automatically entered in the original amount. If the user is permitted to edit the original amount (allowed in user setup) they can enter a different price there and the percent entered will apply to the "new" original amount. This only applies to D or G percents, since M is a function of the cost of the item.  
3.1.10.1.6. Allow Invoice Price Change
3.1.10.1.7. Allow Zero (0.00) Prices
3.1.10.1.8. Consider MINPRICE in Pricing Calculations
3.1.10.1.9. SalePrice Usage
3.1.10.1.9.1. Both OE and E-Commerce
3.1.10.1.9.2. OE Only
3.1.10.1.9.3. E-Commerce Only
3.1.10.2. User Defined Fields
3.1.10.2.1. String Fields
3.1.10.2.1.1. User Def. 1 (OE UserDefS1)
3.1.10.2.1.2. User Def. 1 format
3.1.10.2.1.3. User Def. 2 (OE UserDefS2)
3.1.10.2.1.4. User Def. 2 format
3.1.10.2.2. Document Date Fields
3.1.10.2.2.1. User Def. 1 (OE UserDefD1)
3.1.10.2.2.2. User Def. 2 (OE USerDefD2)
3.1.10.2.3. Memo Fields
3.1.10.2.3.1. User Def. 1 (OE UserDefM1)
3.1.10.2.3.2. User Def. 2 (OE UserDefM2)
3.1.10.2.4. OE Detail Req Field Name
3.1.10.2.5. OE User Defined Date
3.1.10.3. Form Defaults
3.1.10.3.1. Default Pick List Order
3.1.10.3.2. Pick by detail Req Date
3.1.10.4. User Defined Discounts
3.1.10.4.1. Discount #1 Description
3.1.10.4.2. Discount #2 Description
3.1.10.4.3. Discount #3 Description
3.1.10.5. Document Colors
Double click in a box to display a color selection palette.  
3.1.10.5.1. Color For Invoices
3.1.10.5.2. Color For Orders
3.1.10.5.3. Color For Quotes
3.1.10.5.4. Color For Credits
3.1.10.5.5. Color For RGAs
3.1.10.5.6. Color For Deposits
3.1.10.5.7. Color For Deletion
3.1.10.6. Dimension Descriptions
3.1.10.6.1. Rentals
3.1.10.6.1.1. Quantity
3.1.10.6.1.2. Dimension
3.1.10.6.2. Dimension Items
3.1.10.6.2.1. Quantity
3.1.10.6.2.2. Dimensions
3.1.10.6.3. Catch Weight Items
3.1.10.6.3.1. Quantity
3.1.10.6.3.2. Dimension
3.1.10.6.3.3. Max Variation %
3.1.10.7. Invoice Deletion
3.1.10.7.1. Ask To Delete Unprinted
3.1.10.7.2. Keep “deleted” Invoices
3.1.10.8. AR Hold
3.1.10.8.1. Days Late Limit
3.1.10.8.2. Mgr Override
This is the password entered when a user wishes to override a credit or past due hold on a customer's account. If left blank then the user need only hit return to override the hold.
3.1.10.9. Picking Ticket Hold
3.1.10.9.1. Never
3.1.10.9.2. Warn
3.1.10.9.3. Mgr Overide
3.1.10.9.4. Do Not Print
3.1.10.10. Order Description Message
3.1.10.11. Auxiliary Number Description
3.1.10.12. Special ‘*’ Item Processing
3.1.10.13. Ship Days (Order to Invoice)
3.1.10.13.1. Order Detail Ship Days
3.1.10.14. Auto Create PO Method
In order entry a user can create or add to an unposted PO to fill unallocated or drop ship quantities. New PO for each order will only allow the user to create a new unposted PO for the item. Accumulate until printed or posted would automatically add to an existing PO until it was printed or posted. If there was no PO that had not yet been printed or posted then a new PO would be created. Always prompt for choice allows the user to decide to create a new PO or add to an existing unposted PO.  
3.1.10.14.1. New P.O. for each Order
3.1.10.14.2. Accumulate until Printed
3.1.10.14.3. Accumulate until Posted
3.1.10.14.4. Always Prompt for choice
3.1.11. IP
3.1.11.1. Costing
3.1.11.1.1. Inventory
The inventory method cannot be changed by the user. If your method of inventory valuation needs to be changed please contact BCR support.  
3.1.11.1.1.1. LIFO
3.1.11.1.1.2. FIFO
3.1.11.1.1.3. Averaging
3.1.11.1.1.4. Standard
3.1.11.1.2. OE Costing
3.1.11.1.2.1. Items Default to Get Cost Entry from User
3.1.11.1.2.2. Finalize Cost When Invoice is Created
3.1.11.1.3. Show Standard Cost in OE
3.1.11.1.4. Zero Avg Cost if Cost if written off in adjustment while leaving qty
3.1.11.1.5. PO Costing
This setting will determine the initial cost on a new PO. Authorized users can override the cost as needed. Note that the cost on the PO screen does not have to match the cost printed on a PO form. Normally though the Standard, or "replacement", cost is used so that the vendor invoice and your expected cost are the same. Using another cost that is not likely to match the invoiced cost could disrupt the process of vendor invoice reconciliation.  
3.1.11.1.5.1.  (Std.) Cost
3.1.11.1.5.2. MR Cost
3.1.11.1.5.3. AVG Cost
3.1.11.1.6. Adjust/Transfers
3.1.11.1.6.1. Inventory
3.1.11.1.6.2. PO Method
3.1.11.1.7. Use Standard Cost from Vendor
This option appears only if the PO Costing option above is set to (Std.) Cost. Items have a standard cost for the item, but they can have one or more vendors assigned and each of those vendors can have a unique standard cost for that item as well. If this option is checked then the PO will be costed using the vendor specific cost.
3.1.11.1.8. Vendor/Class Discount Not Inverted 
3.1.11.1.9. Posting Accounts
3.1.11.1.9.1. Revenue
3.1.11.1.9.2. Cost of Goods Sold
3.1.11.1.9.3. Inventory
3.1.11.1.9.4. Inventory Shrinkage
3.1.11.1.9.5. AP Clearing
3.1.11.2. User Defined
3.1.11.2.1. Item Fields
The entry here will be the label for the user defined field located on the Edit tab (middle left of screen) in Edit Items. If there is no entry in this field then the field will not be displayed.
3.1.11.2.1.1. User Def 1
The entry here will be the label for the user defined field located on the Edit tab (middle left of screen) in Edit Items. If there is no entry in this field then the field will not be displayed.
3.1.11.2.1.2. User Def 2
The entry here will be the label for the user defined field located on the Edit tab (right of User Def 1) in Edit Items. If there is no entry in this field then the field will not be displayed.
3.1.11.2.2. Vendor/Item User Defined Fields
3.1.11.2.2.1. User Def 1
3.1.11.2.2.2. User Def 2
3.1.11.2.2.3. User Def 3
3.1.11.2.2.4. User Def 4
3.1.11.3. Additional
3.1.11.3.1. Field 1
3.1.11.3.2. Field 2
3.1.11.3.3. Field 3
3.1.11.3.4. Field 4
3.1.11.3.5. Field 5
3.1.11.3.6. Field 6
3.1.11.3.7. Field 7
3.1.11.3.8. Field 8
3.1.11.3.9. Field 9
3.1.11.3.10. Field 10
3.1.11.3.11. Field 11
3.1.11.3.12. Field 12
3.1.11.3.13. Field 13
3.1.11.3.14. Field 14
3.1.11.3.15. Field 15
3.1.11.3.16. Memo 1
3.1.11.3.17. Memo 2
3.1.11.3.18. Memo 3
3.1.11.4. Misc
3.1.11.4.1. Miscellaneous
3.1.11.4.1.1. Default PO Document
3.1.11.4.1.2. # of Copies
3.1.11.4.1.3. Pricing Update Default
3.1.11.4.1.4. PO Line Expected Receipt Date
3.1.11.4.1.5. Simple Counts for Physical Inventory
3.1.11.4.1.6. Use Form Designer for Transfer
3.1.11.4.1.7. for BOM Log
3.1.11.4.1.8. Pieces Entry on PO
3.1.11.4.1.9. Landscape
3.1.11.4.1.10. Use COGS account
3.1.11.4.1.11. Use Processes
3.1.11.4.1.12. Allow Negative Inventory
Checking this option will permit users to allocate quantities beyond what the system believes to be available. Only check this option if you do not care to maintain inventory in real time, or have a basic operational flow that requires that inventory not be updated by receipts before it is allocated. An example might be that a delivery driver can pick up goods that you did not have available from another source. But there may be alternatives to handling this that will not necessitate driving the inventory negative. Contact BCR support for additional help.
3.1.11.4.1.13. Available < 0 is negative (vs 0)
3.1.11.4.1.14. Price Level
3.1.11.4.1.15. E-Com
3.1.11.4.1.16. Edit Warehouses
Click this button to setup and maintain your warehouse locations in Titan.
3.1.11.4.1.16.1. Warehouse Location
3.1.11.4.1.16.2. Cost Center
3.1.11.4.1.16.3. Rental Location
3.1.11.4.1.16.4. Rental/Primary Location
3.1.11.4.1.16.5. Primary Purchasing Location
3.1.11.4.1.16.6. Address
3.1.11.4.1.16.6.1. Warehouse Name
3.1.11.4.1.16.6.2. Address 1
3.1.11.4.1.16.6.3. Address 2
3.1.11.4.1.16.6.4. City
3.1.11.4.1.16.6.5. State
3.1.11.4.1.16.6.6. Zip
3.1.11.4.1.16.6.7. Phone
3.1.11.4.1.16.6.8. Fax
3.1.11.4.1.16.7. Inventory by Picking Locations
3.1.11.4.1.16.7.1. Active
3.1.11.4.1.16.7.2. Allow Duplicate Lot #s
3.1.11.4.1.16.7.3. Validate Location
3.1.11.4.1.16.7.3.1. No
3.1.11.4.1.16.7.3.2. Warning Only
3.1.11.4.1.16.7.3.3. Yes
3.1.11.4.1.16.7.4. Lot/Pick Location Selection
3.1.11.4.1.16.7.4.1. Manual
3.1.11.4.1.16.7.4.2. Automatic
3.1.11.4.1.16.7.5. Default Receiving Pick Location
3.1.11.4.1.16.7.6. Default Interim Pick Location
3.1.11.4.1.16.8. Consignment Inventory
3.1.11.4.1.16.8.1.1. Consignment Location (Vendor’s Inventory)
3.1.11.4.1.16.9. Contra  Liability
3.1.11.4.1.16.10. Contra  Asset
3.1.11.4.1.16.11. Transfer Revenue
3.1.11.4.1.16.12. EDI
3.1.11.4.1.16.12.1. Qualifier
3.1.11.4.1.16.12.2. ID
3.1.11.4.1.16.13. Pick List
3.1.11.4.1.16.14. Warehouse Management
3.1.11.4.1.16.14.1. Picking Method
3.1.11.4.1.16.14.1.1. Order selected by user
3.1.11.4.1.16.14.1.2. Order selected by Program
3.1.11.4.1.16.14.1.3. Wave Method (Program control)
3.1.11.4.1.16.14.2. Pick List Printing Method
3.1.11.4.1.16.14.2.1. On Demand
3.1.11.4.1.16.14.2.2. From Wireless
3.1.11.4.1.16.14.3. Printer Selection (From Wireless)
3.1.11.4.1.16.14.3.1. Pick List Printer
3.1.11.4.1.16.14.3.2. Setup
3.1.11.4.1.16.14.4. RF Reader Model
3.1.11.4.1.16.14.4.1. 700 Series (Worth Data)
3.1.11.4.1.16.14.4.2. 800 Series (Worth Data)
3.1.11.4.1.16.14.4.3. Windows-Based Terminal
3.1.11.4.1.16.15. Add
3.1.11.4.1.16.16. Delete
3.1.11.4.1.16.17. (grid)
3.1.11.4.1.17. Post Receipts to GL
3.1.11.4.1.18. Allow Non-Posting Items
3.1.11.4.1.19. Allow Auto-Allocate Inventory after Receiving
3.1.11.4.1.20. After Transfers
3.1.11.4.1.21. Allow manual Allocation Also
3.1.11.4.1.22. Detailed Sales Tax by Item
3.1.11.4.1.23. Print Pick Lists
3.1.11.4.1.24. Catch Weights
3.1.11.4.1.25. Consignment Items
3.1.11.4.1.26. Track Picked Status
3.1.11.4.1.27. Receipt Print Using Dialog
3.1.11.4.1.28. Consolidate Receipt Posting Batches
3.1.11.4.1.29. Use Multipliers for Import Cost
3.1.11.4.1.30. Allow Available Based On Sales Order Qty
3.1.11.4.1.31. Allow Customer Reserved Inventory for Availability
When checked this option enables customer reserved inventory. Inventory quantities for specific items can be reserved for specific customers. Regardless of how many of that item are available, the quantity reserved cannot be allocated to any other customer. For example, customer Acme may have 5 of item A reserved. Even though there are 7 of the item available, only 2 could be sold to any customer other than Acme. Reserved items are maintained in Edit Customer on the Items tab.  
3.1.11.4.1.32. Use Replenish-From for Inventory Re-Stock
3.1.11.4.1.33. Require Item Unit of Measure Validation
3.1.11.4.1.34. Units of Measure are Uppercase
3.1.11.4.1.35. Synchronize
3.1.11.4.2. Receiving Defaults
3.1.11.4.2.1. All
3.1.11.4.2.2. None
3.1.11.4.3. Price List Pricing Cost
3.1.11.4.3.1. Item
3.1.11.4.3.2. Price List
3.1.11.4.4. MRP
3.1.11.4.4.1. Use MRP
3.1.11.4.4.2. Build To Forecast
3.1.11.4.4.3. Build To Order
3.1.11.4.4.4. # of Days in Each MRP Period
3.1.11.4.4.5. Use Qty On Sales Order
3.1.11.4.5. Warehouse Mgmt
The BCR warehouse management system (WMS) is an optional product. It must be installed by BCR support. The Use WM checkbox must be checked to enable the WMS menus in Titan once it is installed. Contact BCR support and refer to WMS documentation for additional information.
3.1.11.4.5.1. Use WM
3.1.11.4.5.2. Allow Over-Ship
3.1.11.4.5.3. Manual Qty Entry
3.1.11.5. Item Pictures
3.1.11.5.1. Item Picture Default Path
3.1.11.5.2. (drive selector)
3.1.11.5.3. (directory tree)
3.1.11.6. EOQ
3.1.11.6.1. EOQ Settings
3.1.11.6.1.1. Purchase Order Cost per Line
3.1.11.6.1.2. Use Invoice Data
3.1.11.6.1.3. Carrying Cost
3.1.11.6.1.4. Auto Update Leadtimes
3.1.11.6.1.5. Max % Change
3.1.11.6.2. Min / Max / Order Qty
3.1.11.6.2.1. Max (Up To) is Order Quantity
If unchecked then the item maximum is the order up to quantity (e.g., the min is 5 and you have 4 and the max is 10 so the system recommends you buy 6 to bring you "up to" 10.) If checked then the maximum is used as the actual order quantity (e.g., the min is 5 and you have 4 and the max is 10 so the system recommends you buy 10.)  
3.1.11.6.2.2. Sum Min/Max from Warehouses when “All Locations” is selected
The system allows you to set a different min and max for all locations separate from individual locations. This facilitates central distribution warehouse schemes. If so leave this box unchecked. Check this bos if a combined purchasing scheme is used to simply total the individual warehouse mins and maxs to determine order quantities.
3.1.11.7. Item Master
3.1.11.7.1. Justification
3.1.11.7.2. Add-On Item Description
Items can be assigned "add on" items. For example, item A can only be sold along with an item B. So if item B is the add on item, when item A is added to a sales order item B is automatically added to the order as well. The entry in this field is the label for the add on item field on the Edit tab in Edit Items (below the Auxillary Item # field). If the field is left blank then the default label will be "Installation Item #".  
3.1.11.7.3. Item Edit Mask
Inventory item IDs can be setup to automatically format a certain way when they are created. For example you may want a hyphen between the first three characters of the ID and the remainder, e.g., 123456 automatically become 123-456. This does not change the actual ID, only the way it appears. So when you search for the item you still only need to enter 123456, the hyphen is assumed. Contact BCR support if you wish to change your item mask.
3.1.11.7.4. Multiple Vendors Per Item
If checked each item can be assigner multiple vendors, though only one can be designated the primary vendor. Unchecked, only one vendor can be designated per item.
3.1.11.7.5.  (dropdown)
3.1.11.7.6. Customers Per Item
If checked each item can be assigner multiple customers. Unchecked only one customer can be designated per item. Customers are assigned to items for the purpose of identifying their unique item IDs and/or descriptions. If only one customer is ever assigned an item it would suggest that the item is purchased exclusively for one customer. Since this is a global setting it would normally be checked.
3.1.11.7.7. Allow Price Field Updates and Reverse Calculation
3.1.11.7.8. Don’t allow duplicate UPC codes
Normally every item has a unique UPC code and so this option would be checked to insure that duplicate UPC codes are not entered. In some cases a company may stock or list more than one item with an identical UPC code in which case this option would need to be checked.
3.1.11.7.9. Item descriptions are converted to uppercase AD, IP, OE
Some companies prefer that all item descriptions be maintained in UPPERCASE so that descriptions have a uniform appearance. Check this option to insure that they are.
3.1.11.7.10. Consider BOM Component Need in Availability
3.1.11.7.11. Factored Cost Display
3.1.11.7.11.1. Show Cost at Each
3.1.11.7.11.2. Show Cost at Factor
3.1.11.7.12. Vendor Catalog(s)
3.1.11.7.13. Minimum Access Levels
3.1.11.7.13.1. Allow Access
3.1.11.7.13.2. Add
3.1.11.7.13.3. List
3.1.11.7.13.4. Pricing
3.1.11.7.13.5. Ordering
3.1.11.7.13.6. Status
3.1.11.7.13.7. BOM
3.1.11.7.13.8. Outline
3.1.11.7.13.9. History
3.1.11.7.13.10. Pictures
3.1.11.7.13.11. Processes
3.1.11.7.14. Item Class Default for New Items
When a new item is added the item class will default to the class selected here but can be overridden. Use the button to the right to lookup a class. If the field is blank then no default class will be assigned.  
3.1.11.7.14.1. … (browser)
3.1.11.7.15. Price Level Descriptions
Entries in the following fields will be used at the labels for these price levels throughout the system with the exception of the Report Writer.
3.1.11.7.15.1. Base
3.1.11.7.15.2. Price A
3.1.11.7.15.3. Price B
3.1.11.7.15.4. Price C
3.1.11.7.15.5. Price D
3.1.11.7.15.6. Price E
3.1.11.7.16. Default Item Lookup Order
Determines which of the various item lookup fields will be the default. The lookup used can be changed when the item list is displayed.  
3.1.11.7.16.1. Show Kits in Lookup
If this option is not checked you will not see kit items in the item list in Edit Items. Kit items are not real products, they are strictly functions of their components. Some parameters, such as price, may apply to the kit and not its components so it may be important to enable this option in order to access the "kit" instead of just its components. If kits are strictly a function of their components then you may not want users to be able to access the kit via item maintenance. It can still be maintained via Edit Kits.
3.1.11.7.16.2. Use OE Extended Lookup
3.1.11.7.17. Assembly User Defined Fields
3.1.11.7.17.1. #1
3.1.11.7.17.2. #2
3.1.11.8. Lot Numbers
3.1.11.8.1. Lot #s User-Defined Fields
The Lots/Pick Locs tab (only displayed for items checked as Lot #s on the Edit tab) of the Status tab in Edit Items contains a Availability grid listing lots for that item. If a label is entered here there will be a user defined column to the far right in the grid.
3.1.11.8.1.1. #1
3.1.11.8.1.2. #2
3.1.11.8.1.3. #3
3.1.11.8.2. Lot Number Creation Method
If the lot numbers of items are pre-assigned by the vendor (e.g., dye lots or expiration dates) then User Entry should be the setting. Year+Day of Year+Seq or Mfr+YMD+Seq(Encoded) might be used if lots are assigned internally.
3.1.11.8.2.1. User Entry
3.1.11.8.2.2. Year+Day of Year + Seq
3.1.11.8.2.3. Mfr + YMD + Seq (Encoded)
3.1.12. PR
3.1.12.1. Limits / Rates
3.1.12.1.1. Social Security (limit company)
3.1.12.1.2. (social security rate) Company
3.1.12.1.3. (social security limit employee)
3.1.12.1.4. (social security rate) Employee
3.1.12.1.5. Medicare (limit)
3.1.12.1.6. (medicare rate)
3.1.12.1.7. Medicare (level 2) (limit)
3.1.12.1.8. (medicare 2 rate)
3.1.12.1.9. FUTA (limit)
3.1.12.1.10. (FUTA rate)
3.1.12.1.11. SUTA (limit)
3.1.12.1.12. (SUTA rate)
3.1.12.2. Posting Accounts
3.1.12.2.1. FIT Liability
3.1.12.2.2. FICA (liability)
3.1.12.2.3. (FICA) Expense
3.1.12.2.4. Medicare (liability)
3.1.12.2.5. (medicare expense)
3.1.12.2.6. FUTA (liability)
3.1.12.2.7. (FUTAA expense)
3.1.12.2.8. SUTA Liability
3.1.12.2.9. SUTA Expense
3.1.12.2.10. Use Sub Accounts
3.1.12.2.11. Allow GL Account Entry
3.1.12.3. SSN Printing
3.1.12.3.1. Print on Employee Stub
3.1.12.3.2. Print on Co. Stub
3.1.12.4. Direct Deposit
3.1.12.4.1. Routing Source
3.1.12.4.2. Last Deposit Date
3.1.12.4.3. Routing Destination
3.1.12.4.4. Deposits That Day
3.1.12.5. Bank
3.1.12.5.1. Default Bank
3.1.12.6. Time Clock
3.1.12.6.1. Intervals _ Minutes
3.1.12.6.2. (clock in) Do Not Round Time
3.1.12.6.3. (clock in) Round To Nearest Interval
3.1.12.6.4. (clock in) Round to Previous Interval
3.1.12.6.5. (clock in) Round To Next Interval
3.1.12.6.6. Clock Out (do not round time)
3.1.12.6.7. (clock out round to nearest interval)
3.1.12.6.8. (clock in round to previous interval)
3.1.12.6.9. (clock in round to next interval)
3.1.12.6.10. Round only at start times
3.1.12.6.11. (rounding selector dropdown)
3.1.12.6.12. Bar Coded Badges
3.1.12.6.12.1. Delimiters
3.1.12.6.13. Show Input
3.1.12.6.14. Allow Minimize
3.1.12.6.15. Hours Starting Day Of Week
3.1.12.6.15.1. Saturday
3.1.12.6.15.2. Sunday
3.1.12.7. Employer to Employee Contributions
3.1.12.7.1. Print on Pay Stub
3.1.12.8. First Shift
3.1.12.8.1. Earliest start time
3.1.13. JC
3.1.13.1. User Defined Fields
3.1.13.1.1. User Defined Field 1
3.1.13.1.2. User Defined Field 2
3.1.13.1.3. User Defined Field 3
3.1.13.1.4. User Defined Field 4
3.1.13.1.5. User Defined Field 5
3.1.13.1.6. User Defined Field 6
3.1.13.1.7. User Defined Field 7
3.1.13.1.8. User Defined Field 8
3.1.14. New Record Defaults
If a new customer record is created from scratch, i.e., not copied from another customer, then these settings will be used. 
3.1.14.1. Customers
3.1.14.1.1. Break-Out Pricing
This selection relates to the additional charge for an Add On Item (the name of this field may be changed in the system defaults IP tab) that is setup in the Item master edit screen.  If this box is checked, the additional item and its price will appear as a separate line on Order Entry documents.  If this box is not checked,  the additional item and charge will be rolled into the master item's price on one line on Order Entry documents.  The additional item might be an installation charge or any other item, tangible or intangible,  appropriate to the master item.  The additional charge is determined by the price of the add on item in its own item record.  
3.1.14.1.2. No Back Orders Allowed
If checked this indicated that the customer does not accept back orders. After the initial shipment on an order the order will automatically be closed and items or quantities not shipped on the order will not show as backordered quantities. Customers with this box checked will have the No Backorders box checked on the Header tab of orders in order entry and it cannot be overridden. If the customer is not check for No BOs here an individual order can still be checked as No Backorder in order entry.  
3.1.14.1.3. OE F12 Display By Ship-To
In order entry on the Detail tab, pressing F12 will display a subscreen listing all of the items the customer has purchase in the past, what they paid, how many they purchased, etc. If this box is checked then the F12 for this customer will only display the items purchased for shipment to the ship to address on that order’s Header tab.
3.1.14.1.4. Active
A customer must be checked as active to have orders entered for them. A customer may have an outstanding AR balance owed but not be Active. Customers that are not Active are colored orange in a customer pick list and the lookup can be checked to list Active Only.
3.1.14.1.5. Exclusive Shipping Method
Check this option if the shipping method (above) is the only method accepted by this customer.
3.1.14.1.6. Taxable
If checked, sales tax will be charged on all items on invoices, based on the above tax authority, when the item sold is also taxable according to the item master. Items that are taxable on that sale have a check in the Tax column on the order Detail tab. The check can be removed on items that are not taxable on that sale. The Taxable box should usually be checked on a customer that is predominately taxable even if they have a tax exemption. If a customer is never taxable then it should not be checked. Non-taxable customers may also be assigned zero tax rate tax authorities. 
3.1.14.1.7. Credit Hold
Check box if you want to place a hold on the selected customer’s credit.  The credit hold prevents you from creating an order for the customer.  The hold can be overridden with the AR Hold Manager Override password from the System Defaults OE tab.
3.1.14.1.8. Late Charges
If checked the customer will be eligible to be charged late charges for late payment of invoices. Late Charges are setup on the System Defaults Late Charges tab on the AR tab. Late charges are created in the Accounts Receivable module with the Generate Late Charges program on the Invoices menu.
3.1.14.1.9. Require ShipTo
If this box is checked than users must select a ship to every time they create an order for this customer. If not checked the system will automatically select either the default ship to, or if there is no default ship to, the primary customer name and address are chosen. In either case the user can override the selection.
3.1.14.1.10. Lock Office Location in OE
Checking this option prevents anyone entering an order for this customer from changing the salesperson assigned above.
3.1.14.1.11. Require Payment
If this box is checked then the user will be prompted to ask for payment before a pick ticket for an order with allocated goods can be printed. This box is usually checked for customers that pick up goods and are COD. Even though they are COD you should check the On Account box.
3.1.14.1.12. Statement
If checked, the customer will be included in the Print Statements run.
3.1.14.1.13. Ship Complete
If checked then all orders for this customer must have all quantities allocated before a pick ticket will print. Either the item that cannot be shipped must be deleted or its order quantity reduced. Otherwise the order will not print until sufficient stock is available to allocate all items and quantities. The Ship Complete box will be checked on the Header tab of the order but can be unchecked to allow printing. The box can also be checked on the order Header tab if the customer option is not checked.
3.1.14.1.14. Auto Xmit Emails
If checked, will send the customer’s statement via the email address in the Statement/Document Email or Fax field, assuming the customer has the Statement box checked.
3.1.14.1.15. Give Change by Default
When a customer tenders more than the amount due in order entry on the Shipping/Payment tab the extra amount can either be applied to the customer's account as an unapplied payment or it can be returned to the customer as change. Checking this box defaults the customer to give them change. That can be overridden on the order by the user if necessary.  
3.1.14.1.16. Xmit Methods
3.1.14.1.16.1. Credit Notes
3.1.14.1.16.2. Invoices
3.1.14.1.16.3. Pick Lists
3.1.14.1.16.4. Quotes
3.1.14.1.16.5. Orders
3.1.14.1.16.6. RMA’s
3.1.14.1.17. Form Defaults
3.1.14.1.17.1. Quotes
3.1.14.1.17.2. Orders
3.1.14.1.17.3. Pick Tickets
3.1.14.1.17.4. Invoices
3.1.14.1.17.5. Credits
3.1.14.1.17.6. RMA’s
3.1.14.1.17.7. Pack Slips
3.1.14.1.17.8. Statement
3.1.14.1.17.9. Doc Printing w/Statement
3.1.14.1.17.10. Add Scanned PO or Tax Information to E-Mailed or Faxed Documents 
3.1.14.1.18. AR Method
If a customer is set to Balance Forward old, unpaid invoices will be summarized as balances for the financial periods when AR Month End Processing (Accounts Receivable>General) is run to update the AR period. If they are set to Open Item then invoices are not summarized. The typical setting is Open Item.
3.1.14.1.18.1. Open Item
3.1.14.1.18.2. Balance Due
3.1.14.1.19. Lock-in Selected AR Method
3.1.14.1.20. Price Cd
Enter a price code from BLANK, and A to E.  This corresponds to the price levels in the Item master file or, if used, the price list. A customer set as “B” will use the B level in the item master and in every price list to which they are assigned. Note that the names of price levels (Blank, A, B, etc.) may be changed in System Defaults and so may be different for your company.
3.1.14.1.21. Default Discount
3.1.14.1.22. Duplicate PO Handling
The system can compare the PO# entered on an order to previous number entered on orders for this customer and WARN the user entering the order that the PO# entered matches another order for that customer in the past. Or it can PROHIBIT the user from using that PO#.
3.1.14.1.23. Terms
Select the customer payment and early payment discount terms from this dropdown.  Terms are created and maintained in the Administration module using the Edit Customer Terms program on the File menu. Terms can be overridden in order entry on the Header tab. 
3.1.14.1.24. Allocation Method
This function allows a company to take orders for product but not allocate inventory to the order.  There are three settings available:  (1) Manual - Quantities ordered are not allocated (0) and the user must manually set the allocation quantity.  (2) Automatic With Override – Quantity ordered is automatically allocated (up to the quantity available) but the user can reduce the quantity.  (3) Automatic Without Override - Quantity ordered is automatically allocated (up to the quantity available) and the user cannot change the quantity.  Automatic Without Override basically turns off the inventory allocation function.
3.1.14.1.25. Credit Limit Test Method
The Cr Limit Method determines when a customer has exceeded their Credit Limit setting. The dropdown options range from just the total of unpaid invoices posted to accounts receivable to the total of all unpaid invoices and orders, including order quantities that have not been allocated to ship.  
3.1.14.1.26. Price List
Select a default price list for this customer.  Price lists allow you to replicate pricing schedules (BLANK and A through E) as many times as necessary for your specific business needs.  You may create several general price lists that can be applicable to many customers, and/or specific price lists related to catalogs or customer contracts.  If the price list field is left blank, the standard price list in the item master is used.
3.1.14.1.27. Credit Limit
In whole dollars, determines the total amount that a customer can owe before orders are automatically placed on credit hold. The total amount “owed” is determined by the Cr Limit Method. The Credit Limit can be overridden in order entry by a manager with the AR Hold Manager Override password set in System Defaults on the OE tab.
3.1.14.1.28. Payment Method
Select the customer’s default Payment Method from the dropdown. Payment Methods are created and maintained with the Edit Payment Methods program on the Edit menu in the Administration module. The Payment Method selected for the customer will be the default on the Shipping/Payment tab in order entry.  
3.1.14.1.29. Auxiliary Number
The auxiliary number field has a user defined label. Examples might be DEPT# or JOB NAME. The Auxiliary Number Description label is defined in Administration>System>Set System Defaults on the OE main tab. If the customer has a default DEPT#, JOB NAME, etc., such as NONE or MAINT, enter that here.
3.1.14.1.30. PO Number
If the customer has a default PO # to be used when no specific number is given for an order, enter it here.
3.1.14.1.31. PO Requirements
Select the purchase order number and auxiliary “Aux” number requirements of this customer . The label for the auxiliary number is user defined.
3.1.14.1.32. Default Item
Will add this item automatically to every new order created for this customer. Enter an item code or use the browse button (...) to the right to open a lookup box.
3.1.14.1.33. Country
Contains the country of the customer, if necessary.
3.1.14.1.34. Shipping Method
Enter the preferred shipping method for this account. This is the shipping method that will pre-fill on orders for this customer. Valid shipping methods are created at Administration>Edit>Edit Shipping Methods. 
3.1.15. Ecommerce
3.1.15.1. Ecomm Customer Creation Based On
3.1.15.2. Ecomm New Cust Default Terms
3.1.15.3. Automatically Populate OE.AUXNUM with First/Last Name
3.1.15.4. Automatically Populate OE.TAXAUTH on new orders
3.2. Setup Users
Only authorized personnel should be allowed access to this program. Any user with access to this program can control the access and options setup for themselves and any others. Typically only the most senior management is permitted to access this program.
3.2.1. OK
3.2.2. Add
3.2.3. Copy
3.2.4. Delete
3.2.5. Reset PW
When a new user is created they are given the password “NEW”.  They should change that password (Module launch pad>File>Change Password) to a password known only to themselves as soon as they begin using the software. That password is encrypted in the data and cannot be viewed. If a user forgets their password or the user ID is to assigned another user, you can force the password back to “NEW” by clicking the Reset PW with that user highlighted. 
3.2.6. Apply To Group
A user Group can be assigned to any user with the Group dropdown (below). For example a user could be assigned the Group SLSPRSN. One user can be setup as a master and when this button is clicked all of the settings for the highlighted user will be copied to users assigned that same group.   
3.2.7. List
3.2.7.1. User (grid)
3.2.7.2. Default Settings
3.2.7.2.1. User Name
3.2.7.2.2. Access Level
3.2.7.2.3. First Name
3.2.7.2.4. Last Name
3.2.7.2.5. Email
3.2.7.2.6. Group
Select an existing Group from the dropdown or enter a new one. Users that have the same setup can be managed as a Group by clicking the Apply To Group button (above).   
3.2.7.2.7. Local SQL Drive
3.2.7.2.8. Default Office Location
3.2.7.2.9. (erase)
3.2.7.2.10. Locked In
3.2.7.2.11. If not locked in, show all
3.2.7.2.12. Default Warehouse Location
3.2.7.2.13. (erase)
3.2.7.2.14. Locked In
3.2.7.2.15. Default Sales Person
3.2.7.2.16. (erase)
3.2.7.2.17. Locked In
3.2.7.3. Custom Display
3.2.7.3.1. Grid Fonts
3.2.7.3.1.1. Font
3.2.7.3.1.2. Size
3.2.7.3.1.3. Bold
3.2.7.3.1.4. Apply New Font
3.2.7.3.2. Header Fonts
3.2.7.3.2.1. Fonts
3.2.7.3.2.2. Size
3.2.7.3.2.3. Bold
3.2.7.3.2.4. Apply New Font
3.2.7.3.3. User Grid Alternating 
3.2.7.3.4. Allow User Help Editing
3.2.7.3.5. Allow Form Design Mode
3.2.7.3.6. Color
3.2.8. Modules
3.2.8.1. Modules
3.2.8.1.1. (check all/none button)
3.2.8.1.2. Administration
3.2.8.1.3. Add New Customers
3.2.8.1.4. Add New Vendors
3.2.8.1.5. Accounts Payable
3.2.8.1.6. Allow Check Processing
3.2.8.1.7. Allow Check Number Edit
3.2.8.1.8. Accounts Receivable
3.2.8.1.9. Contact Management
3.2.8.1.10. Fixed Assets
3.2.8.1.11. General Ledger
3.2.8.1.12. Reports/Setup/Year-End
3.2.8.1.13. Inventory/Purchasing
3.2.8.1.14. Job Costing
3.2.8.1.15. Order Entry
3.2.8.1.16. Item View
3.2.8.1.17. Payroll
3.2.8.1.18. Manufacturing
3.2.8.1.19. Change Dataset
3.2.8.2. Admin File Menu
3.2.8.2.1. (check all/none button)
3.2.8.2.2. Edit Customers
3.2.8.2.3. View Only
3.2.8.2.4. Edit Vendors
3.2.8.2.5. View Only
3.2.8.2.6. Edit Sales Staff
3.2.8.2.7. Edit Fiscal Periods
3.2.8.2.8. Edit Chart of Accounts
3.2.8.2.9. Edit Item File
3.2.8.2.10. Edit Prices too?
3.2.8.2.11. Edit Jobs
3.2.8.2.12. Edit Customer Terms
3.2.8.2.13. Edit Vendor Terms
3.2.8.2.14. Edit PO Special Orders
3.2.8.3. Job Costing Options
3.2.8.3.1. Job Costing in AP
3.2.8.3.2. Job Costing in IP
3.2.8.3.3. Job Costing in AR
3.2.8.3.4. Job Costing in PR
3.2.8.4. Admin General Menu
3.2.8.4.1. (check all/none button)
3.2.8.4.2. Edit Price Lists
3.2.8.4.3. Edit Pricing Categories
3.2.8.4.4. Assign Customer Price Lists
3.2.8.4.5. Edit Assortment Discounts
3.2.8.4.6. Edit Price Schedule Codes
3.2.8.4.7. Edit Item Classes
3.2.8.4.8. Edit Kits
3.2.8.4.9. Edit Sales Tax Tables
3.2.8.4.10. Edit Checking Accounts
3.2.8.4.11. Edit Shipping Methods
3.2.8.4.12. Edit Credit Card Types
3.2.8.4.13. Edit Payment Methods
3.2.8.4.14. Edit Processes
3.2.8.4.15. Edit Currencies
3.2.8.4.16. Edit Routes
3.2.8.4.17. Edit GL Entries
3.2.8.4.18. Edit GL Cost Centers
3.2.8.4.19. Edit GL Sub Accounts
3.2.8.4.20. Edit Order Types
3.2.8.4.21. Edit Makes/Models
3.2.8.5. Admin System Menu
3.2.8.5.1. (check all/none button)
3.2.8.5.2. Edit System Defaults
Only senior management should be allowed access to this program. Users with access to this program can make very significant changes to the way that the software operates and can disable it completely. 
3.2.8.5.3. Edit Users (or level 9)
Only senior management should be allowed access to this program. A user with access to this program effectively controls the access and permissions of all users, including their own. 
3.2.8.5.4. Display User Activity
3.2.8.5.5. Reindex / Pack Database
3.2.8.5.6. SQL Tools
Only senior management should be allowed access to this program. SQL (standard query language) allows users to view and modify database records directly. Some training is required to utilize SQL. Significant and irreversible damage can be caused to your data by improper or malicious use of this very powerful tool.  
3.2.8.5.7. Import (generic)
3.2.8.5.8. Form Designer
Access to this is the same as access to the Report Writer.  
3.2.8.5.9. Post Inventory Residual Values
3.2.8.5.10. Purge Documents
3.2.8.5.11. Matrix Inventory
3.2.8.5.12. Change Customer ID
3.2.8.5.13. Change Vendor ID
3.2.8.5.14. Change Item ID
3.2.8.5.15. Change GL Account ID
3.2.8.5.16. Inventory Price Change
3.2.8.5.17. Quick Price Edit
3.2.8.5.18. Item Cost Update
3.2.8.5.19. Setup GL Account Structure
3.2.8.5.20. Validate Data
3.2.8.5.21. Vendor Catalog
3.2.8.6. Other
3.2.8.6.1. Report Writer
3.2.8.6.2. At Work Display
3.2.8.6.3. Manufacturing Setup
3.2.8.6.4. Management Information Screen
3.2.8.6.5. Zip Lookup
3.2.8.6.6. E-mail Show Outlook
3.2.8.6.6.1. Show Screen
3.2.8.6.6.2. Don’t Show
3.2.8.7. Notes Access
3.2.8.7.1. Customer OE Notes
3.2.8.7.2. Customer AR Notes
3.2.8.7.3. Vendor Notes
3.2.8.7.4. Add New Notes
3.2.8.7.5. Edit Existing Notes
3.2.8.8. Toggles All or None
3.2.9. Accounts Receivable
3.2.9.1. General/Administration Functions
3.2.9.2. Change Customer Credit Hold Settings
3.2.9.3. Allow User to Create a New Customer by Copying Existing Customer
3.2.9.4. Default Customer Status (Lookup)
3.2.10. Accounts Payable
3.2.10.1. Account Selection Default – Invoice Entry
3.2.10.1.1. GL Account
3.2.10.1.2. Items
3.2.10.1.3. Receipts
3.2.10.1.4. P.O. Number
3.2.10.1.5. Reference #
3.2.10.2. Default Invoices to On Hold during Batch Entry
3.2.11. Order Entry
3.2.11.1. Document and Header
3.2.11.1.1. Create
3.2.11.1.1.1. Invoices
3.2.11.1.1.2. Orders
3.2.11.1.1.3. Quotes
3.2.11.1.1.4. Credit Notes
3.2.11.1.1.5. RGA’s
3.2.11.1.2. Based On
3.2.11.1.2.1. Invoices
3.2.11.1.2.2. Orders
3.2.11.1.2.3. Quotes
3.2.11.1.2.4. Credit Notes
3.2.11.1.2.5. RGA’s
3.2.11.1.3. Printing
3.2.11.1.3.1. All Types
3.2.11.1.3.2. Orders Only
3.2.11.1.3.3. Invoices Only
3.2.11.1.3.4. Quotes Only
3.2.11.1.4. Contracts
3.2.11.1.4.1. Allow Billing
3.2.11.1.5. OE Partial Copy
3.2.11.1.5.1. Don’t All Partial Copy
3.2.11.1.5.2. Allow Partial Copy
3.2.11.1.5.3. Default to Partial Copy
3.2.11.1.6. Create Multiple from Multiple
3.2.11.1.6.1. Don’t Allow Multiples
3.2.11.1.6.2. Allow Multiple Docs
3.2.11.1.6.3. Default to Allow
3.2.11.1.7. Always clear the Customer ID on the New tab
3.2.11.1.8. Miscellaneous
3.2.11.1.8.1. Change Order
3.2.11.1.8.2. Allow Auto-Invoicing
3.2.11.1.8.3. Force Auto-Invoice Orders
3.2.11.1.8.4. Show Cost in Price Lookup Tab
3.2.11.1.8.5. Customer Add
3.2.11.1.8.6. Customer Delete
3.2.11.1.8.7. Allow Auto-Purchase Order Creation
3.2.11.1.8.8. Allow User to Kill Invoices
3.2.11.1.8.9. Allow User to Kill Orders
3.2.11.1.8.10. Location of OE Buttons
3.2.11.1.8.10.1. Right (Standard)
3.2.11.1.8.10.2. Top
3.2.11.1.8.10.3. Left
3.2.11.1.8.11. Invoice Office Location from Order Office Loc
3.2.11.1.8.12. See AR from Order Entry
3.2.11.1.8.13. Print Picking Ticket Instead of Order
3.2.11.1.8.14. Show Customer Drop Down List on New Tab 
When this box is checked this user will see a drop down selector for customers on the New tab in Edit Invoices/Orders/Quotes. When the user clicks in this selector they can begin typing a customer name and the box will immediately find the first customer matching that text string. The user can also use the scroll bar or keyboard arrows to locate a customer. Most companies will want to make this selector available to all users. Companies with extremely high numbers of customers on file may find that this selector degrades the program start up time and is not practical for customer selection. These companies may wish to uncheck this box for users.
3.2.11.1.8.15. Prompt User on Creation of New Document
3.2.11.1.8.16. Require Enteredby
3.2.11.1.8.17. Allow User to Cancel Orders
3.2.11.1.9. Header Tab
3.2.11.1.9.1. Allow Date Change
3.2.11.1.9.2. Allow Salesman Change
3.2.11.1.9.3. Allow Required Date Change
3.2.11.1.9.4. Allow Terms Change
3.2.11.1.9.5. Change Tax Authority
3.2.11.1.9.6. Allow Change Customer on Orders
3.2.11.1.9.7. Allow Region Change
3.2.11.1.9.8. Allow Change Price List
3.2.11.1.9.9. Default to PO Number Field
3.2.11.1.9.10. Allow After Posting PO# Modification
3.2.11.1.9.11. Allow After Posting Bill-To Modification
3.2.11.1.9.12. Allow After Posting Ship-To Modification
3.2.11.2. Detail Tab Settings
3.2.11.2.1. Show Cost in Detail Screen
3.2.11.2.2. Show Margin
3.2.11.2.3. Show Standard Cost On Detail Screen
3.2.11.2.4. Allow Line Printing Enable/Disable (F9)
3.2.11.2.5. Allow Customer Price List Change from Entered Price
3.2.11.2.6. Allow Standard Cost Modification
3.2.11.2.7. Warn if duplicate stocked item entered
3.2.11.2.8. Non-stocked item
3.2.11.2.9. Allow Discount Entry/Change
3.2.11.2.10. Default to Discount On Current User Price
3.2.11.2.11. Show Prior Price/Display Message if Different
3.2.11.2.12. Show Based On Values on Detail Pricing Tab
3.2.11.2.13. Sample GiveAway
3.2.11.2.14. Scan Mode (Auto Advance to Next Line)
3.2.11.2.15. Allow Create new PO Vendor for items
3.2.11.2.16. Auto-complete item #
3.2.11.2.17. Allow Assembly Build Editing During Auto Build
3.2.11.2.18. Require Order Quantity Entry – Even if Zero
3.2.11.2.19. Allow Zero Cost (Get Cost Items Only)
3.2.11.2.20. Allow to allocate more than available (Also see system Defaults)
3.2.11.2.21. Detail Date Field is Required
3.2.11.2.22. Show commission in Detail grid
3.2.11.2.23. Allow user to add new items in OE
3.2.11.2.24. Require Min Qty on Sales Order, Instead of Warn User
3.2.11.2.25. Price Changes
3.2.11.2.25.1. Require Price be Cost plus %
3.2.11.2.25.2. Price Change Options
3.2.11.2.26. Access Detail Tab Information
3.2.11.2.26.1. (check all/none)
3.2.11.2.26.2. Purchase Orders
3.2.11.2.26.3. Quotes
3.2.11.2.26.4. Sales Orders
3.2.11.2.26.5. Invoices
3.2.11.2.26.6. Pictures and Links
3.2.11.2.26.7. Serial Numbers
3.2.11.2.26.8. Customer Messages
3.2.11.2.26.9. Vendors
3.2.11.2.26.10. Quantities By Warehouse Location
3.2.11.2.26.11. Pricing By Level
3.2.11.2.26.12. Alternate Code Item Association
3.2.11.2.26.13. Equivalent Code Item Association
3.2.11.2.27. Detail Extended Description
3.2.11.2.27.1. Preferred Extended Description
3.2.11.2.27.2. Default to Inside Sales When Text Is Present
3.2.11.2.27.3. Flash Inside Sales
3.2.11.3. Detail Tab Access/Widths
3.2.11.3.1. Set Defaults
3.2.11.3.2. Item (20)
3.2.11.3.3. Location (3)
3.2.11.3.4. Description (21)
3.2.11.3.5. Unit of Measure Sales (6)
3.2.11.3.6. Qty Ordered (7)
3.2.11.3.7. Qty Allocated (7)
3.2.11.3.8. Qty Shipped (7)
3.2.11.3.9. Cost (10)
3.2.11.3.10. Price (10)
3.2.11.3.11. Extended Price (10)
3.2.11.3.12. Date (10)
3.2.11.3.13. Customer Price Level (1)
3.2.11.3.14. Customer Price List (8)
3.2.11.3.15. Customer Price Level
3.2.11.3.16. Vendor (6)
3.2.11.3.17. PO Number (7)
3.2.11.3.18. PO Line (6)
3.2.11.3.19. Qty Originally Ordered (10)
3.2.11.3.20. Cut Qty (7)
3.2.11.3.21. Cut Dimension (7)
3.2.11.3.22. Price Lookup Field Widths
3.2.11.3.22.1. Item (30)
3.2.11.3.22.2. Description (50)
3.2.11.3.22.3. Qty On PO (8)
3.2.11.3.22.4. Qty On Hand (10)
3.2.11.3.22.5. Qty Allocated (10)
3.2.11.3.22.6. Qty Available (8)
3.2.11.3.22.7. Price (10)
3.2.11.3.22.8. Unit Sales (6)
3.2.11.3.22.9. UPC Code (13)
3.2.11.3.22.10. Alt Code (10)
3.2.11.3.22.11. Eqv Code (10)
3.2.11.3.22.12. Mfr Item (30)
3.2.11.3.22.13. Class (10)
3.2.11.3.22.14. ID (6)
3.2.11.3.22.15. Aux Number (30)
3.2.11.3.22.16. Manufacturer (20)
3.2.11.3.22.17. Pick Loc (15)
3.2.11.3.22.18. Unit Purch (6)
3.2.11.3.22.19. Weight (10)
3.2.11.3.22.20. Lead Time (10)
3.2.11.3.22.21. Box Qty (10)
3.2.11.4. Detail Field Visiblity 
3.2.11.4.1. Drop Ship Check Box
3.2.11.4.2. Unit Of Measure Sales
3.2.11.4.3. Vendor ID
3.2.11.4.4. Original Amount Settings
3.2.11.4.4.1. Visible
3.2.11.4.4.2. Edit Non-Stock Tangible
3.2.11.4.4.3. Edit Non-Stock Non-Tangible
3.2.11.4.4.4. Edit Stock
3.2.11.4.5. Date
3.2.11.4.6. Pick Date
3.2.11.4.7. Price List
3.2.11.4.8. Price Level
3.2.11.4.9. Price Level Description
3.2.11.4.10. Customer Item Number 
3.2.11.4.11. Customer ID
3.2.11.4.12. Warehouse Picking Location
3.2.11.4.13. PO & PO Line
3.2.11.4.14. Cost
3.2.11.4.15. Margin
3.2.11.4.16. Location
3.2.11.4.17. Package Size 
3.2.11.4.18. Taxable Checkbox
3.2.11.4.19. MfgItemNo
3.2.11.4.20. DESC2
3.2.11.5. Utilities/Premium
3.2.11.5.1. OE Order Allocation/Change – Premium Product
3.2.11.5.1.1. Allow Order Qty Change
3.2.11.5.1.2. Allow Allocation Qty Change
3.2.11.5.1.3. Allow Price Change/Override
3.2.11.6. Shipping/Payment
3.2.11.6.1. Credit Card Edit Mask
3.2.11.6.2. Credit Card Display Mask
3.2.11.6.3. Autorun Signature Capture after CC Auth.
3.2.11.6.4. Print Deposit Ticket after CC Auth.
3.2.11.6.5. Signature Capture Device Type
3.2.11.6.6. Deposit Button Caption
3.2.11.7. Menu Selections
3.2.11.7.1. Sales
3.2.11.7.1.1. (check all/none)
3.2.11.7.1.2. Import
3.2.11.7.1.3. Print Pick Tickets
3.2.11.7.1.4. Print Packing Slips
3.2.11.7.1.5. Hold/Release Invoices
3.2.11.7.1.6. Allow Release All
3.2.11.7.1.7. Print Process Doc Range
3.2.11.7.1.8. End Of Day Posting
3.2.11.7.2. General
3.2.11.7.2.1. (check all/none)
3.2.11.7.2.2. Show Customer Activity
3.2.11.7.2.3. Edit Customer Notes
3.2.11.7.2.4. Cash Drawer Setup
3.2.11.7.2.5. Edit PO Special Orders
3.2.11.7.3. Report
3.2.11.7.3.1. (check all/none)
3.2.11.7.3.2. Invoice Journal
3.2.11.7.3.3. Sales Activity Summary
3.2.11.7.3.4. Customer Sales Activity
3.2.11.7.3.5. Invoice Detail
3.2.11.7.3.6. Invoice Summary
3.2.11.7.3.7. YTD/MTD Sales
3.2.11.7.3.8. Sales By Class
3.2.11.7.3.9. Cash Receipts
3.2.11.7.3.10. Sales Tax (Detail)
3.2.11.7.3.11. Sales Tax (Summary)
3.2.11.7.3.12. Sales Tax Jurisdiction (Detail)
3.2.11.7.3.13. Sales Tax Jurisdiction (Summary)
3.2.11.7.3.14. OE Charts
3.2.11.7.3.15. Work Orders
3.2.11.7.3.16.  Commission
3.2.11.7.4. Delivery
3.2.11.7.4.1. (check all/none)
3.2.11.7.4.2. Delivery Manifest including inbound
3.2.11.7.4.3. Invoice Pick/Pack 
3.2.12. Inventory/Purchasing
3.2.12.1. General
3.2.12.1.1. Default PO Listing Order
3.2.12.1.1.1. Vendor Name
3.2.12.1.1.2. P.O. Date
3.2.12.1.1.3. P.O. Number
3.2.12.1.2. Default Item Lookup Scope
3.2.12.1.2.1. Primary Only
3.2.12.1.2.2. Or Secondary
3.2.12.1.2.3. All Items
3.2.12.1.3. Maximum PO $ Amount
3.2.12.1.4. Allow Override
3.2.12.1.5. Require Requestor for P.O.
3.2.12.1.6. Allow User to Kill Purchase Orders
3.2.12.1.7. Functional Warehouse Exclusion List
3.2.12.1.7.1. Function
3.2.12.1.7.2. Warehouse
3.2.12.1.7.3. Add
3.2.12.1.7.4. Delete
3.2.12.1.8. Warehouse Management
3.2.12.1.8.1. WM RF User
3.2.12.1.8.2. WM Manager Access in OE
3.2.12.2. Menu Selections
3.2.12.2.1. Inventory
3.2.12.2.1.1. (check all/none)
3.2.12.2.1.2. Enter/Edit Purchase Orders
3.2.12.2.1.3. Physical Inventory Count
3.2.12.2.1.4. Enter/Edit Receipts
3.2.12.2.1.5. Enter/Edit Adjustments
3.2.12.2.1.6. Enter/Edit Transfers
3.2.12.2.1.7. Build Assemblies
3.2.12.2.1.8. Auto-Generate Purchase Orders
3.2.12.2.1.9. Edit PO Special Orders
3.2.12.2.1.10. Enter/Edit Vendor Returns
3.2.12.2.1.11. Intra-Warehouse Transfers
3.2.12.2.1.12. Print Purchase Orders
3.2.12.2.1.13. Print Physical Inventory Counts
3.2.12.2.1.14. Print Receipts Log
3.2.12.2.1.15. Print Adjustments Log
3.2.12.2.1.16. Print Transfer Logs
3.2.12.2.1.17. Post Purchase Orders
3.2.12.2.1.18. Post Receipts
3.2.12.2.1.19. Post Adjustments
3.2.12.2.1.20. Post Transfer
1. UnPost Purchase Order(check all/none button)
3.2.12.2.2. Reports
3.2.12.2.2.1. (check all/none)
3.2.12.2.2.2. Display Item Activity
3.2.12.2.2.3. Open Purchase Orders
3.2.12.2.2.4. Item Activity
3.2.12.2.2.5. Item History
3.2.12.2.2.6. Inventory Valuation
3.2.12.2.2.7. Inventory Requirements
3.2.12.2.2.8. Customer Movement
3.2.12.2.2.9. Where Used
3.2.12.2.2.10. Inventory Labels
3.2.12.2.2.11. Allocations
3.2.12.2.3. General
3.2.12.2.3.1. (check all/none)
3.2.12.2.3.2. Purge MTD Inv Counts
3.2.12.2.3.3. Purge YTD Inv Counts
3.2.12.2.3.4. Archive Transaction History
3.2.12.2.4. Scheduling
3.2.12.2.4.1. (check all/none)
3.2.12.2.4.2. Build Forecast
3.2.12.2.4.3. Forecast
3.2.12.2.4.4. Material Requirements
3.2.12.2.4.5. Production Schedule
3.2.12.2.5. Delivery
3.2.12.2.5.1. (check all/none)
3.2.12.2.5.2. Delivery Manifest including inbound
3.2.12.2.5.3. Invoice Pick/Pack
3.2.12.3. Item Master
3.2.12.3.1. Allow user to zero/edit average cost in Item Edit
3.2.12.3.2. Allow Lot #/Bin Location Editing
3.2.12.3.3. Allow “Ask Later” on Lot Tracking (will prompt for Lots again before Posting)
3.2.12.3.4. Allow Min/Max EOQ Editing in Admin
3.2.12.3.5. Show Quick-Add screen by default
3.2.12.3.6. Allow editing of Average Cost on the item master ordering tab
3.2.12.3.7. Show Inactive items in Item Master
3.2.13. Report Writer
3.2.13.1. (grid)
3.2.13.1.1. Table
3.2.13.1.2. Access
3.2.13.2. All
3.2.13.3. None
3.2.13.4. Complete Access
3.2.13.5. Allow Excel Spreadsheets from Reports
3.2.14. Sub Database
3.2.14.1. Location of Sub Database
3.2.14.2. Clear
3.2.15. Troubleshooting
3.2.15.1. Speed Tracking
3.2.15.2. Pricing Evaluation
3.3. User Activity
3.4. Reindex/Pack Databases
3.5. SQL Tools
3.6. Import (Excel)
3.7. Import (Generic)
3.8. Forms Designer
3.9. E-Commerce Setup
3.9.1. Trigger Maintenance
3.9.2. E-commerce Setup
3.9.3. Setup Database Tracking
3.10. Post Inventory Residual Values
3.11. Close or Archive/Purge Documents
3.11.1. Order Entry
3.11.2. Inventory/Purchasing
3.12. Matrix Inventory
3.13. Change/Merge Customer ID
3.14. Change/Merge Vendor ID
3.15. Change/Merge Item Number
3.15.1. Change/Merge Single Item
3.15.2. Batch Processing Setup (Item Change Only)
3.15.3. Process Batch Item # Change
3.16. Change/Merge G/L Account #
3.17. Change Tax Authority
3.18. Change Salesperson
3.19. Inventory Price Changes
3.20. Inventory Quick Price Edit
3.21. Inventory Cost Update
3.22. Setup Account Structure
3.23. Re-Sync Inventory
3.24. Validate Data
3.25. Vendor Catalogs
3.25.1. Import Materials Express/PFMS
3.25.2. Trade Services Edit
3.25.3. Trade Services Import
3.25.4. Batch Transfer To Item Master
3.25.5. Vendor Cross-Reference
3.25.6. Copy Vendor Catalog to Item File
3.25.7. Quantity Conversion Table
3.25.8. Aristokraft Cabinet Update
3.25.9. SMC Pneumatics
3.25.10. Harris Publishing
3.25.11. E-Z View
3.26. Link Images to Items
4. Reports
4.1. Print Customer List
4.2. Address Labels
4.3. Print Vendor List
4.4. Chart Of Accounts Listing
4.5. Item Master List
4.5.1. By Description
4.5.2. By Number
4.5.3. By Class
4.5.4. By Vendor
4.6. Create File For Barcode Labels
4.7. Bill Of Material Explosion
4.8. Item Listing with Images
4.9. Managment Information
4.10. Customer Price List
4.11. Rebates
4.12. Rebate Master Setup
4.13. Customer/Rebate Type Selection
4.14. Price List/Rebates
5. Imports
5.1. Setup
6. Window
6.1. Tile
6.2. Cascade
6.3. Arrange All
6.4. Status Bar
6.5. Toolbar
6.6. 640x480
6.7. 800x600
6.8. 1024x768
6.9. 1280x720
6.10. 1440x900
6.11. Main Menu
7. Help
7.1. About...
7.2. Titan Support Connection
8. EDI
8.1. In
8.1.1. EDI 810 (Invoice)
8.1.2. EDI 850 (Purchase Order)
8.1.3. EDI 855 (Purchase Order Acknowledgment)
8.1.4. EDI 820 (Remittance Advice)
8.2. Out
8.2.1. EDI 810 (Invoice)
8.2.2. EDI 820 (Remittance Advice)
8.2.3. EDI 850 (Purchase Order)
8.2.4. EDI 855 (PO acknowledgement)
8.2.5. EDI 856 (Advance Shipping Notice)
8.2.6. EDI 867 POS
9. Developer
9.1. ItemDet
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